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Basic Concepts
Indeed, this is all explained in the MSI SDK (click ) document but it is a long read, technical
and assumes that you know some of the concepts already. Therefore here are the basics.

Packages (.MSI files)
This is the file that contains the instructions for MSIEXEC.EXE to install the application.  The
MSI file is a Database file format and is now the preferred application packaging format for the
windows platform. Sometimes the MSI file gets too big and some or all of the files are placed in a .
CAB file.

Transforms (.MST files)
In the MSI world, if you didn't create the MSI file, you want to keep the MSI file from the
developer intact. To make changes beyond what the original MSI does you use a transform. The
transform is applied at the time that the MSI package is installed. Why is this a big deal? In the old
days (that includes today as well!) if you would repackage an application and it would fail, the
Original Developer of the application would sometimes refuse to support it since repackaging
strips out their installation logic. In the Developer’s mind, you modified their application. With
MSI and transforms you avoid that charade.

If you create your own MSI packages you can also use transforms to change some parameters for
each department of your company. That way you have only one package to maintain and nobody
can accuse you of doing a better package for one department vs. another. It’s the same bloody
package.

 Transform files are in fact MSI files with a different file extension. The contents of both files are
merged together at install time. They are not supposed to add files to the package but there are
way. Wise Package Studio does allow adding files using Transforms but they create a CAB file to
bring files in without breaking the MSI rules.

Merge Modules
This is another one of MS’ idea to prevent DLL HELL. Merge Modules are groups of shared DLLs
and OCXs that depend on one another. If your SetupCapture picks up one or more shared DLLs for
which there is a Merge Module for, then those files are removed from your package and the
appropriate Merge Modules are substituted in its place. 

When you go to edit a package that contains Merge Modules, you don't see the contents of the
Merge Modules that make up your package. If you want to see them: Edit menu ->Preferences->
Installation Expert tab-> check the Show merge modules components.

These files are available for download through WPS, Wise Solutions Technical Support Center
(for registered users only) and at http://www.installsite.org/ under Merge Modules. When you buy
Wise Package Studio (WPS), they are also on the CD.

MSI Rollback
This is what MSIEXEC does during an installation if it runs into an error and can undo the changes
it did up to the point that the error occurred.
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Restricted Users (aka Limited Users)
OS MS' terminology

95,98,ME n/a (Security? Everybody is admin in 9x!)

NT 4.0 Restricted Users

Windows 2000 USERS (2/3 down the page)

Windows XP Limited USERS

Windows 2003 Limited USERS (???)

Sucessor to Windows XP tba

This is the User Account type that prevents users from installing applications ( err..almost!).  

In the old days, LAN Admin would create the User accounts as administrators, install the all
software the user needed into his profile and then make the user account a  “Restricted User”. The
real fun began when you had to maintain such a thing. 
Today, you can use MSI to install applications that require administrator access for Restricted
Users. It does this by running the MSI installer as a service on the target workstation.

If you install an application for all users on the computer (or assign software to the computer
account via GPOs) the software is fully installed only for user that initiated the install. All other
existing and future users of the computer will have their installation completed next time they
login and/or launch the application. The process used to complete these installations on the fly is
unofficially called “User profile fix-up detection”. This is in fact a special case of self-healing
feature of MSI. The catch is that most MSI packages don’t do this well if at all. You can, however,
tweak the MSI package using Transforms to perform the changes properly.

Err..Almost: Even Restricted users can install/run some unwanted applications. This include self-
contained applications that require no installation per se and applications that install files to the
user's own profile and keys to the User's registry hive. The latter does exist but are few since most
home windows users run with an Administrator account. Developers are more than happy to
trade their users' security for fewer support calls.

Wise Package Studio (WPS) vs. Wise for Windows Installer (WfWI)
WPS is meant to repackage applications into MSIs whereas WfWI is meant to generate MSI
packages from scratch or from a Visual C/C++ code (ie.: for developers). Hence, WfWI has no
SetupCapture or Transform creation capability.

 WfWI version 3.2 and lower had SetupCapture and Transform creation capability and was able
to repackage applications into MSI, since then Wise has created 2 separate products lines.

WPS: WSI vs. MSI files
In Wise Package Studio (WPS), after you capture an installation, it creates a WSI file along with
the MSI file. You can edit the MSI file directly but it is preferred to recreate the MSI file using the
WSI file. Doing so gives you more options when creating MSI packages. 
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WPS: The Wise Share Point
In Wise Package Studio (WPS), this is the default path for the captured packages. It is selected at
install time of WPS. It is meant to be used as a central location for all packages, source files, WSI
files and many other shared resources. In it you have a projects folder. That is where you create
sub-folders for each of your packaging projects.

WPS: SetupCapture
SetupCapture is the program in Wise Package Studio (WPS) used to repackage an application’s
setup.exe package into an MSI package. Usually you tell it to create a WSI file instead of an MSI
file directly. The WSI file is the working file from which you  later compile it, with the source
files, into an MSI file.

WPS: InstallTailor
Install Tailor is the program in Wise Package Studio (WPS) used to create Transforms (.MST) an
application’s setup.exe package into an MSI package. Unlike SetupCapture, you create an MST
file directly and edit the MST file directly.(there is no such thing as a WST file in Wise)

WPS: Windows Installer Editor (WIE)
Install Tailor is the program in Wise Package Studio (WPS) used to edit MSI packaged and
Transforms (.MST). The is also the tool you use to edit WSI working files from which you  later
compile it, with the source files, into an MSI file. (BTW: Yes this is the same tool in Wise for
Windows Installer.)

WPS: Standard vs. Professional vs. Enterprise version
Wise has 3 classes for their WPS product:
-Standard costs the least and includes WiseScript Express.
-Pro costs 2-3 time more that Standard but add Client/Server setup and the full WiseScript Editor.
Pro also add the much touted “Virtual Capture” feature but few people use it and nobody in the
newsgroups answers questions about it.
-Enterprise costs more than Pro and is targeted to places that have many packagers and need to
track/coordinate their work. It adds more reports and few more features.

All 3 versions can share the same SharePoint  provided that the versions are matched-up. Ie.
WPS 4.62 Standard and WPS 4.62 Pro can use the same SharePoint . 

If you upgrade the SharePoint  (by upgrading one Workstation) the other lower versions of WPS
will be locked out. The only thing that really locks them out is the Workbench database. None of
the packages in the projects folder are changed. If you use the conflict resolution and package
distribution functionality (of Pro and up) then those features will probably be affected too.

Feature
In MSI land this is usually a division in your package to separate major functions. For example in
MS Office, Excel and Word are separate features of the Office MSI package. Features are also
meant to be able to be complete by themselves. If feature share files and registry settings for some
things like spell checking, those are usually spun off as a separate feature that Excel and Word
depend on.
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 In Wise Package Studio when you capture a setup, it usually creates only one feature called
Complete. You can add features manually or add them using a feature SetupCapture.  A feature
can also be sub-divided into Components. 

You can even have feature that install automatically depending on conditions. These are called
Conditional Features.

Component
A grouping of files and/or registry keys that are usually related to one another. Similar to the idea
of a feature but provides a small functionality of a feature. Different features can use the same
components.

Note: Some MSI packagers like On Demand’s WinInstaller create one component for each registry
entry and file. This makes the package hard to troubleshoot but also eliminates many ICE Errors.

KeyPath
This term is used over and over but is not explained well. It is a specific Registry key or File that a
component sees as most critical. When an MSI-based application is launched, it checks these
critical registry keys and files or KeyPaths. If one of them does not match with what is in the MSI
then the component related to that KeyPath is re-installed. This process is known as self-healing.

The fun in troubleshooting MSI comes when the KeyPath is set to a moving target like a
temporary file or volatile registry entry like “last run time” or size/location of a window. This in
turns triggers self-healing. You can change the KeyPath for components in WPS.

Properties:  Variables in MSI
Variables in MSI are called properties.
Then can be set in the MSI tables in the package, set using a custom action in the MSI package, as
a parameter if launched through the command line or using a transform.

The SDK mentions many "predefined" properties and says that some are initialized at runtime. If
their name is ALL_UPPERCASE then they are known as public properties which can be set from
the command line.

Gotcha #2: Properties are CaSe-SeNsItIvE. You can have Widget, widget, and WIDGET as
properties in the same MSI package. The catch is that only WIDGET will be settable from the
command line.

Gotcha #2: ROOTDRIVE and ROOTDRIVE_ with a space at the end are different. Spaces
count as characters!

Custom Actions
MSI technology runs on scripting. You can add to this script as you see fit. The catch is that these
Custom Actions are not logged and are not undoable during a rollback. They can be used to
uninstall the old non-MSI version of an application and other non-trivial things. You can do very
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fancy things like using a Custom Action to call a DLL which tests unlock codes to your
application.

Unattended Install
If you want to install unattended and want to use all the defaults in the menus, launch the MSI
from the command line with the –QN switch. 

If you want to install unattended but need to change something in the menus, then you must use a
transform and launch the MSI from the command line with the –QN switch. 

If you will be using GPOs to launch the MSI packages the same rules apply except the -QN
switch is implied.

Advertising
This is the way that applications are made available to be installed without actually being installed.
This is used for Install-on-Demand purposes. This feature is meant to be used when distributing
the package via GPOs or SMS or ZENworks. The package is assigned (via GPO) to a user and if
the user launches the shortcut or opens a file with an extension associated to that package, then the
package is installed for that user. The shortcuts and file associations are also called Entry Points to
the package. 

If you install an application for all users on the computer (or assign software to the computer
account via GPOs) the software is fully installed only for user that initiated the install. All other
existing and future users of the computer will have their installation completed next time they
login and/or launch the application using these special shortcuts. The process used to complete
these installations on the fly is unofficially called “User profile fix-up detection”. This is in fact a
special case of self-healing feature of MSI. 

File over-write logic
What happens when a file in the package already exists on the target PC? In the old days it was
whatever the author of the setup.exe felt like and that created what is known as “DLL HELL”. 
MSI has rules for this:
Highest version wins

Most files (EXE, DLL, etc.) have version numbers inside (Right-click-> Properties ->
Version tab to see them). If a file that exists in both the package and on the target PC, the
file with the highest version number will be copied (or left) on the machine. This is
regardless of the file date.

Version wins over no-version
If one of the files doesn’t have version number then the file with the version number will be
copied (or left) on the machine.

Files with no version number is user data
If the file already exists on the PC it is NOT overwritten.

In some cases you really need to break these rules. Use the “companion file” feature of MSI to do
that which is covered in the FAQ.
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Not-So-Basic Concepts
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Product Code vs. Package Code
The Product Code is a GUID that is used to determine if a certain type of your application is
already installed on the Target PC. Think of it as a model number or model name. For example:
MS would use the same Product Code for Outlook 2003 regardless of the native language of the
package. Therefore Outlook 2003 French version, Outlook 2003 USA version and Outlook 2003
Swedish version would all have the same Product Code.

The Package Code is a GUID that is used to determine if a certain version of your application is
already installed on the Target PC. Think of it as a serial number of your package. For example:
MS would use a different Package Code for Outlook 2003 for each native language version of the
package. Therefore Outlook 2003 French version, Outlook 2003 USA version and Outlook 2003
Swedish version would all have different Package Codes.

Ok, I know what you are thinking: WHY!
Well I know you can use the Product Code to uninstall an application. In MS' case, if you try to
install Outlook 2003 French over top of the Outlook 2003 English on your PC, the package would
say that it's already installed.

You cannot, however, use a Package Code to uninstall an application. Other than using it as a
serial number I don't know what it's good for.

One thing you could do is use the same Product Code for a package that you plan on updating a
lot. That way, you would automatically be told that your old version is already installed and needs
to be uninstalled first. I could see other things this could be used for.

You can get the Product Code in the Installation Expert tab in Project Details:

You can get the Package Code in the Setup Editor tab in :

Both can also be found as Properties in Setup Editor.

Installing MSP files
Gotcha: If you perform a silent install of an MSP file like this: 
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msiexec /p patch.msp /qn

it will not patch an existing installation. It will only update the locally cached copy of the MSI
database. Use this command line instead: 

msiexec /p patch.msp REINSTALL=ALL REINSTALLMODE=vomus

Double-clicking the .MSP file will patch an existing installation as well as the locally cached copy
of the MSI database because the dialogs are run and they in turn set REINSTALL and
REINSTALLMODE for you. When you run the patch unattended,  the dialogs are not displayed
and the properties are not set. This is why the properties must be set at the command line.

How to uninstall MSP patches
The only way to uninstall a patch is to uninstall the MSI, the patch will come off with it. The
ability to just remove the patch is something that [might be] planned in MSI 3.0.  People say that
you may be better off creating a proper upgrade MSI rather than an patch file (at least until
Windows Installer version 3.0 delivers on its promises to make patches a easier and more stable.)
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Building your “Rig”
Like most repackagers, Wise Package Studio (WPS) uses 2 snapshots to record changes: 

1. Take a before snapshot
2. Install your application and make all the changes you want (patches, tweaks, etc.)
3. Take an after snapshot
4. Compare snapshots to record changes.

Once you’ve created your MSI package you need a second PC to test it while keeping the original
installation intact on the other PC. Therefore, in general, you need a minimum of 2 PCs to
repackage applications effectively: a Snapshot PC and a Testing PC.

The “CleanPC”
Also referred to as a “Clean Machine” or “Clean Image”, it is a minimal install of the OS and OS
patches and the IE browser. We will use this image as a base to build the Snapshot PC and the
Testing PC. This image should not be used prior to imaging in order to keep the registry as clean
as possible. Just launching an application will populate the User hive and possible the Machine
hive as well. If possible, have the OS installed by automated means (Unattended install of
windows). This way, your image will always be consistent and clean of usage. We’ll explain how
you can build that later.

 Some applications will need another application installed before your particular “setup.exe” will
run. For those we make a special case and install that application prior to running SetupCapture.
(ie. Some applications will need MS-Office installed as well and for those we install MS-Office
prior to running SetupCapture.) We do not make it part of the CleanPC image.

What follows are applicable to Wise Package Studio version 4.5 to 4.62. Version 5.x is slightly
different (ie no WPSclient.exe but a client still exists) and I will update if there is demand for it.

The “standard” setup (for WPS standard version)

This is the cheapest way to capture packages since you need only 2 PCs to build Packages. The
fileserver is optional since you could have the SharePoint  on a D drive on the Snapshot PC. You
can also use any existing server for the SharePoint . You can install the Pro version this way as
well but you miss out on the Client-Server benefits. (Also, if you do install the Pro version this
way, you’ll have extra screens compared to what is shown here.) 

The Snapshot PC
This is a “CleanPC” that runs the Wise Package Studio (WPS) software locally to capture the
actions of a Setup.exe. This PC will need to be re-imaged after each package and therefore will
need a D drive formatted in FAT32 to store the images. The fileserver is optional since you could
have the SharePoint  on the D drive as well to save your packages.
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The Testing PC
This is another “CleanPC” that you can test your packages on. The idea is to keep the original
installation intact on the Snapshot PC so that if your package fails on the Testing PC you can
compare easily, change and compile again on the Snapshot PC while the Testing PC is being re-
imaged. Once you are satisfied that your package works on the CleanPC, you can load the
corporate image on the Testing PC and test again. As you can see this PC will need to be re-
imaged after each test and therefore will need a D drive formatted in FAT32 to store the images.

Building the Snapshot PC and installing WPS
As hinted above, you create a “Clean PC” and install Wise Package Studio (WPS) on it:

1. Partition into C: and D: drive (ie. 8GB for C drive and the rest for D drive)
2. Format D drive as FAT32
3. Perform install of Windows to C:  (unattended if possible)
4. Bootup with Windows 95/98 from a floppy
5. Take image an image of C: and save it to the D drive (call it CleanPC.gho or CleanPC.PQI

depending on your imaging software)
6. Reboot and login as the local Administrator (Why? If you login as a network user that has

local Administrator privileges you will probably also get a GPO applied. You don’t want
your package to contain GPO settings. If you know better than me than suit yourself. )

7. Wise SharePoint :
Option A: Create a folder on the D drive (call it WPS), share it (with change permissions)
and map a drive letter (let’s say W) back to that folder. This will be for the Wise
SharePoint . (Why? This way you won’t have to re-install the snapshot PC if you need to
move the Wise SharePoint  folder to another machine. Windows 2000/XP doesn’t care is
you map to something you are sharing on the same machine. )

OR
Option B: You can map a drive letter (let’s say W) to a server with tones of drive space for
the Wise SharePoint .

OR
Option C: If Option A & B are too hard to understand or doesn’t make sense to you then
just accept the defaults. (BTW: You can also change this later.)

8. Start the installation of WPS and enter the serial number(s) as needed. Follow the defaults
except for the screen below.
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If you use the default D:\WiseSharePoint If you use a mapped drive letter like W:

Note that I changed Wise Share Point to WiseSharePoint. Removing the spaces helps for
scripting purposes.
9. Continue until completed.

Configuring WPS on the Snapshot PC
10. Extract the merge modules to the Wise Share Point.(this is on one-time thing)

-Run the MergeModules.MSI off the WPS CD and point it to a sub-directory
called MergeModules in the Wise Share Point. You will need your serial number to
unlock it. (You may be able to get an updated file from Wise Solutions Technical
Support Center as them come out.)

      Or
-Copy the Merge Modules from the WPS CD to a sub-directory called
MergeModules in the Wise Share Point. ( Gotcha: You get fewer merge modules
this way)

11. From the Start Menu, Launch Wise Package Studio (WPS)

12. In the Workbench, select the Edit menu -> Preferences
-Put a check in the box for “Run all tools in Full Screen Mode”
-Click Ok
-Exit WPS

13. Bootup with Windows 95/98 from a floppy
14. Take image an image of C: and save it to the D drive (call it Snapshot.gho or Snapshot.PQI)
15. Your Snapshot PC is ready.

Building the Testing PC
As hinted above, you create a “Clean PC” and tweak it:

1. Partition into C: and D: drive (ie. 8GB for C drive and the rest for D drive)
2. Format D drive as FAT32
3. Perform install of Windows to C:  (unattended if possible)
4. Bootup with Windows 95/98 from a floppy
5. Take image an image of C: and save it to the D drive (call it CleanPC.gho or CleanPC.PQI)
6. Reboot and login as the local Administrator (Why? If you login as a network user that has

local Administrator privileges you will probably also get a GPO applied. You don’t want to
test your package with GPOs all the time. If you know better than me than suit yourself. )

7. Map a drive letter to the Wise Share Point the same way as on Snapshot PC. If you went
with the defaults you’ll have to share the D:\WiseSharePoint. Since you already have a D:
drive on the Testing PC you’ll have to map it to a different drive letter. (Options A & B for
the Snapshot PC sure look good now.)

8. Bootup with Windows 95/98 from a floppy
9. Take image an image of C: and save it to the D drive (call it Testing.gho or Testing.PQI)
10. Your Testing PC is ready.
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The “client-server” setup (for Pro version and up)

This is the best way to capture packages on the Snapshot PC due to how little it “pollutes” (aka its
“footprint”) your CleanPC. You will need 3 PCs to build Packages. What follows are applicable to
version 4.5 to 4.62 of Wise Package Studio.

The “Packaging server”
This is a regular workstation or fileserver that will have a Full install of Wise Package Studio Pro.
It will need to be able to share files. Once setup, there is little need to touch it since you can do
everything by installing the WPSClient.exe on another PC. The PC can also be used for the Share
Point. ( Gotcha: The STD version of Wise Package Studio (WPS) does not include
WPSclient.exe and therefore cannot be setup in client-server mode.) 

 Since the “Packaging Server” has a full install of WPS you could use it to edit existing packages
but don’t use it to capture since you need re-image it between packages. 

The Snapshot PC
This is a “CleanPC” that runs the WPS software through a share from the “Packaging server” to
capture the actions of a Setup.exe. The actual EXEs are located on the “Packaging Server” and you
use the WPS Client on the Snapshot PC to get to them. In fact you will have this item in your start
menu:

This PC will need to be re-imaged after each package and therefore will need a D drive formatted
in FAT32 to store the images.

The Testing PC
This is another “CleanPC” that you can test your packages on. The idea is to keep the original
install intact on the Snapshot PC so that if your package fails on the Testing PC you can compare
easily, change and compile again on the Snapshot PC while the Testing PC is being re-imaged.
Once you are satisfied that your package works on the CleanPC, you can load the corporate image
on the Testing PC and test again. As you can see this PC will need to be re-imaged after each
package and therefore will need a D drive formatted in FAT32 to store the images.

Building the “Packaging server” and installing WPS Pro
1. Install Windows 2000/XP to C:  
2. Create a folder called WPS, share it as “SHAREPOINT” with change permissions and map

a drive letter (let’s say W) back to that folder, this will be for the Wise Share Point. (Why?
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This way you won’t have to re-install the snapshot PC if you need to move the Wise Share
Point folder to another machine. Windows 2000/XP doesn’t care is you map to something
you are sharing on the same machine. If this is too hard to understand or doesn’t make
sense to you then just accept the defaults. (BTW: You can fix this it later.)) 

3. Start the installation and enter the serial number(s) as they are needed. Follow the defaults
except for the screens below.

 

If you use the default D:\WiseSharePoint If you use a mapped drive letter like W:

Note that I changed Wise Share Point to WiseSharePoint. Removing the spaces helps for
scripting purposes and other snafus. 

4. At the Clean Machine screen check the box

Gotcha: Though not well explained, now is the time to check the box and not when you are
installing the WPSClient.exe on the Clean Machine. By checking this option, WPS will create a
bunch of .dat files instead of creating a real database for the workbench database. If you don’t do
this now, you will NOT be able to use the minimal installation of Wise Package studio later. 

Another gotcha includes the inability to convert to these .dat files later without a re-install of the
share point and loosing all of the previous project entries in the workbench database. (NOTE: In
WPS 5.0, .dat files are gone )
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 Minimal Client vs. Full Client:
Minimal Client installs fewer files on the Clean PC than a Full Client install. 
The Full Client adds Crystal Report drivers and more. If your target application tries to install
such things they will not be part of the resulting package. The Minimal Client does have less
functionality but I never use those features. 
5. Continue until completed.

 NOTE about Database types:
If you do not choose the Minimal Install option then you should choose to use MS Access
instead. 

         
Though Wise gives you the option to connect to a MSDE or MS SQL database server, they do
not tell you of the pros-and-cons or even when you would need such a complicated setup. I
have seen MSDE for download on MS’ site at one time but I have since lost its link.

Configuring WPS on the “Packaging server”
6. Extract the merge modules to the Wise Share Point. (This is a one time thing)

-Run the MergeModules.MSI off the WPS CD and point it to a sub-directory
called MergeModules in the Wise Share Point. You will need your serial number to
unlock it. (You may be able to get an updated file from Wise Solutions Technical
Support Center as them come out.)

      Or
-Copy the Merge Modules from the WPS CD to a sub-directory called
MergeModules in the Wise Share Point. ( Gotcha: You get fewer merge modules
this way)

7. From the Start Menu, Launch WPS

8. In the Workbench, select the Edit menu -> Preferences
-Put a check in the box for “Run all tools in Full Screen Mode”
-Click Ok
-Exit WPS

Configuring for WPSclient.EXE:
9. Create the WPSDIR Share 

Share C:\Program Files\Wise Package Studio as WPSDIR 
NOTE: The Wise Share Point should already be shared as SHAREPOINT in step 2

10. Edit config.ini in the root of the Wise Share Point. This file is used by the WPSclient.exe
to configure some parameters automatically upon install. The following assumes that the
computer name of the Packaging server is WPS_SERVER and that you are going to map to
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the Wise Share Point using a drive letter. You can use UNC paths but that would force
you to keep the Wise Share Point on the same computer. 

[Share Point]
Version=5.01
[Edition]
PS=10
[Databases.Workbench]
1=workbench
[Workbench.1]
DSN=Workbench Database
Type=ACCESS
Name=workbench
Server=
SqlAuth=0
[DSN]
Workbench Database=Workbench.1
Wise Software Repository=Repository.1
[Databases.Repository]
1=repository
[Repository.1]
DSN=Wise Software Repository
Type=ACCESS
Name=repository
Server=
SqlAuth=0

11. Create a batch file called WPSclient_install.BAT in the root of the Wise Share Point.

::REM The following is suppose to be one line
\\WPSSERVER\WPSDIR\wpsclient.exe SERIALNUM="0123456789"
PREVSERIAL="0123456789" SHAREPOINT="W:\WiseSharePoint"
WPSDIR="\\WPSSERVER\WPSDIR\" MODULESPATH="W:\WiseSharePoint\Merge
Modules" NOCRYSTAL=1 /Qb
::Disable update check, etc.
regedit /s WPS_Custom_settings.reg

12. Not all desired settings are automated. So we improvise. Create a file called
WPS_Custom_settings.reg in the root of the Wise Share Point.

Windows Registry Editor Version 5.00
;stop nagging to check for updates on every launch 
[HKEY_CURRENT_USER\Software\Wise Solutions\Workbench\Settings]
"UpgradeRemind"=dword:00000000
;Make all tools fullscreen upon launch
"Fullscreen"=dword:00000001

Building the Snapshot PC and installing WPS
As hinted above, you create a “Clean PC” and install Wise Package Studio (WPS) on it:

1. Partition into C: and D: drive (ie. 8GB for C drive and the rest for D drive)
2. Format D drive as FAT32
3. Perform install of Windows to C:  (unattended if possible)
4. Bootup with Windows 95/98 from a floppy
5. Take image an image of C: and save it to the D drive (call it CleanPC.gho or CleanPC.PQI

depending on your imaging software)
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6. Reboot and login as the local Administrator (Why? If you login as a network user that has
local Administrator privileges you will probably also get a GPO applied. You don’t want
your package to contain GPO settings. If you know better than me than suit yourself. 

7. Map a drive letter (let’s say W) to the Wise Share Point on the Packaging Server
8. Browse to W:\WiseSharePoint and run the batch file called WPSclient_install.BAT
9. Bootup with Windows 95/98 from a floppy
10. Take image an image of C: and save it to the D drive (call it Snapshot.gho or

Snapshot.PQI)
11. Your Snapshot PC is ready.

Building the Testing PC
As hinted above, you create a “Clean PC” and tweak it:

1. Partition into C: and D: drive (ie. 8GB for C drive and the rest for D drive)
2. Format D drive as FAT32
3. Perform install of Windows to C:  (unattended if possible)
4. Bootup with Windows 95/98 from a floppy
5. Take image an image of C: and save it to the D drive (call it CleanPC.gho or CleanPC.PQI

depending on your imaging software)
6. Reboot and login as the local Administrator (Why? If you login as a network user that has

local Administrator privileges you will probably also get a GPO applied. You don’t want to
test your package with GPOs all the time. If you know better than me than suit yourself. )

7. Map a drive letter (let’s say W) to the Wise Share Point on the Packaging Server
8. Bootup with Windows 95/98 from a floppy
9. Take image an image of C: and save it to the D drive (call it Testing.gho or Testing.PQI)
10. Your Testing PC is ready.
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Building the “CleanPC” unattended
Also referred to as a “Clean Machine” or “Clean Image”, it is a minimal install of the OS and OS
patches and the IE browser. This image should not be used prior to imaging in order to keep the
registry as clean as possible. Just launching an application will populate the User hive and possible
the Machine hive as well. If possible, have the OS installed by automated means (Unattended
install of windows). This way, your image will always be consistent and clean of usage. Here we
explain how you can build that CleanPC in an automated way.

Required files
-Working install of Windows (must match the version you want to automate.)
-Setupmgr.exe for that version of Windows (look it up on your CD or MS’ site)

Procedures
Install and Run Setupmgr.exe (aka Setup Manager) and select Create an answer file that
duplicates this computer’s configuration.
Select Unattended install
Select Fully automated
Enter Administrator Password and make it auto-login 2 times (we can adjust this later)
For Network Settings, select Typical settings
Select Yes, edit the additional settings
For distribution Folder, select No, this answer file will be used install from a CD

Edit winnt.sif
To prevent conflict with other Machines names on the network change the Machine name in the
winnt.sif file before you first start the unattended install. For example call the Snapshot PC
“SNAPSHOT” and the Testing PC “TESTER”. Now put the modified winnt.sif file on a floppy
and use it to install Windows. If you must, have one floppy for each PC.

Optional 1: Create CleanPC.bat to map the W: drive for you and lock the Computer password to
prevent having to re-join the domain after the image is 20-30days old. This will work if the GPO
doesn’t in turn prevent locking the Computer password.

Optional 2: Create Cleanup.bat to cleanup all of the temp files, etc. This makes your image files
smaller.

Using the Winnt.sif floppy
To start Windows Setup unattended from the Windows product CD

1. The computer must support booting from the CD-ROM drive (Check CMOS setup if
necessary) and the NIC must be support by the drivers on the CD. Otherwise see caveat
below.

2. When prompted be the Press any key to boot from CD message at the bottom of the
screen, press the space bar to confirm that you want to boot from the CD.

3. Insert the floppy with the Winnt.sif file as soon as the computer boots from the CD (before
you see the drivers being loaded at the bottom of the blue screen)

4. You should be able to go on from here.
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Set your preferences
After you have build a CleanPC image, configure the computer the way you need it so that it is not
so annoying that you could inadvertently change during a SetupCapture session. This could
include:
-Windows explorer settings (like current folder, hidden files, etc)
-Keyboard layout selection (ie. No TBITS)
-Disable Windows Auto Updates
-Etc.
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Procedures
To use or not to use Projects
In the Wise Package Studio (WPS) Workbench you have 2 tabs: Projects and Tools.

Using Projects is the preferred method because it types in fields automatically for you, creates WSI
files with “Relative File Paths” and copies the source files to the Share Point. With “Relative File
Paths” you don’t need to install the package just to do small change and compile a new MSI.  The
other bonus about using “Relative Source Paths” is that if you move the contents of project folder
or rename the project folder, you'll will still be able to compile the MSI. If you stay with the
default Absolute Source Path, you'll have to go to Change Source Paths in the tools menu to
change the Source Paths. Also, if you consistently (and properly) use projects, others people can
check to see how one package or another is progressing.

The only catch with Relative File paths is when you need to add files. Even if you add them in the
proper folder in the Share Point, WPS is not smart enough to notice that the rest of the package is
using relative file paths. YOU must fix that manually.
Either way, I will show you how to use Wise Package Studio with and without Projects.

WPS: How to create a MSI package from a setup.exe (No Project)
Document each step used to create the package. 
The purpose is to facilitate the recreation the package in case of an error (major or minor), to
facilitate the packaging of future versions of the same package and helps to build other packages in
case a special fix or tweak was used to get this package to work. If you can, use the documentation
from a previous application that you packaged as a base and modify accordingly (or use the one
from my tutorial). What follows is in fact a generalized version of one of those documents. Please
note however that every package is different.
 I prefer to create these documents using WordPad since it is already installed in Windows and
does not use tones of files. I use a filename that matches with the WSI filename. (MyApplication-
v123.WSI => MyApplication-v123.wri) Using the WRI extension ensures that WordPad will
always be used to edit the document even when MS-Word is installed.

If you notice a step that is always done on all packages, the MSI template should then be upgraded
with those changes so that they are never forgotten and not explicitly documented in all package
documents.  

If you must skimp on documentation, at least document anything unusual that you may have
done in a package.
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Capturing the Setup Process
-Restore the Clean Image on the Snapshot PC (It should already have the WPSClient.EXE
installed with drive mapping to the Wise Share Point)
-Logon as Local Administrator
-Launch Wise Package Studio
-Click Tools tab
-Launch SetupCapture
-Target installation: W:\WiseSharePoint\Projects\APPNAME-VER\APPNAME-VER.WSI
-Select “Copy Source files during installation save”

-Destination Directory: W:\WiseSharePoint\Projects\APPNAME-VER
or W:\WiseSharePoint\Projects\APPNAME-VER\FILES

-Check the box for “Store Source File Pathnames as Relative Pathnames”

-Click Next
-Click Next
-Capture Methodology: leave it at Snapshot but uncheck SmartMonitor. Click Next

-Click Next
-Begin installation capture; click Next to take initial snapshot of system
-Click Browse to locate the setup.exe
-Click Execute to launch the setup.exe (required for SmartMonitor to work if you do use it)
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-Follow the menus for the setup.exe.
-Make all changes required to make the program work.
-Document anything that is not default
-If possible do not run the application since some self-configure on first run

-Come back to SetupCapture window when done
-Click Next
-Click Next to take second snapshot of system
-Review SetupCapture Inclusions; change if necessary and click Next

-To exclude a file select the file and click Exclude

Note: The Exclude Globally adds the exclusion to the
WisePSSC.ini file for all future snapshots. Careful!

-Click Next
-Review SetupCapture Exclusions; if necessary and click Next

-To include a file select the file and click Include
-At the finish window

If you plan to deploy the MSI Package using GPOs, add the Version to the name
or else 2 versions of the same application will display the same name.

-Fix the Name of the application to include the version (ie. AppName to AppName 3.0)
-Match the version of the program
-Update the manufacturer 
-Make sure the Default Folder is correct. 
(It’s usually the main folder for that application located under Program Files)

-Click Finish
-If you get the Files in Merge Modules window similar to this:

     

Gotcha: If you plan to use the
“Application Isolation” feature
and the DLL or OCX you want to
isolate is part of one of the
Merge Modules, you will not
have that DLL (or OCX)
available to use the “Application
Isolation” feature. Unselect the
Merge Module that contains that
DLL (or OCX) and leaves the
rest of the Merge Modules alone.

-Click Ok
-If required, download any missing Merge Modules.

-If the download fails you can try again but do it while you are still here in SetupCapture.
Otherwise the merge modules won’t stick.

-Save the WSI
At this point, if you have chosen the proper non-default settings as I mentioned herein, Wise
Package Studio will now copy all the files that make up the package to the Wise Source Point and
make all references to then in the WSI file relative. This way you will not have to install the
application just to make a simple change.
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Editing the package 
While still on the Snapshot PC:
-Edit the <pkg name>.WSI file in W:\WiseSharePoint\Projects\<pkg name> folder.

Gotcha: Always use the WSI file and not the MSI file for editing.

-In the Installation Expert view:
In Product Definition section select Add/Remove Programs

-Click Browse to add the icon for the application 

NOTE: Fancy icons are optional in Add/Remove Programs.  Otherwise a generic
Icon is used in the Add/Remove Programs applet on the target PC.

In Feature Details section select Files
-Remove or add files that were missed during the SetupCapture process

Save WSI package

Go to the Setup Editor view:
-Click the Tables tab

-Go to Property table
-In right panel, right-click New -> New Row

-Click OK to acknowledge the warning
-In the property column enter: ROOTDRIVE 

Gotcha: Properties in UPPERCASE are Public
properties in MSI. Also ROOTDRIVE and
ROOTDRIVE_ with a space at the end are different.

-In the Value column enter: C:\

NOTE: This will prevent MSI to install on the drive with most free space
and guaranty that it will always install on the C: drive of the Target PC.

-In right panel, right-click New -> New Row 
-Click OK to acknowledge the warning
-In the property column enter: ALLUSERS (In UPPERCASE, no trailing spaces)
-In the Value column enter: 1

NOTE: This will force the application to install for all users and use the “All
Users Profile”. This is preferable so that different users on the same machine
don’t have to have the application reinstalled for each new user.

Save WSI package
-Click Compile to create new MSI package
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WPS: How to edit an existing MSI (No Project)
If you have the WSI and used “Relative source file Pathnames”
-Just locate the .WSI file in the projects folders and double-click it
-When you are done compile yourself a new MSI file. 
(Remember to backup your .WSI file)

If you have the WSI and the MSI file only
This means that you did not check the box for “Store Source File Pathnames as Relative
Pathnames”, compiled MSI file and then wiped the Snapshot PC. Here the source files exist only
inside the MSI file. This means that you must install the application so that WPS can get to them
when it re-compiles the MSI file.
-Install the application from the .MSI on a Clean PC (I suggest the Snapshot PC)

Gotcha: You may have to install using the same User that was used to create the
original WSI file during the SetupCapture. Making the install “to the machine” may
place some file in the AllUsers profile instead of the current user profile. This is why it
is recommended to capture using the Administrator profile. 

-Open the .WSI file
-Do your changes
-Save the WSI.
-Click Compile to create an updated MSI file. 
(NOTE: this will overwrite the previous MSI file unless you back it up)

If you have the MSI file only
Here the source files exist only inside the MSI file. This means that you must install the
application so that WPS can get to them when it re-compiles the MSI file.
-Install the application from the .MSI on a Clean PC (I suggest the Snapshot PC)
Wise Package Studio does support recompiling the MSI file directly but doing so will give
different one than if you still had the .WSI file that you had originally.
You, however, can create a .WSI file from an MSI file this way:
-Create a new project folder in the SharePoint  and copy your target MSI file into it.
On the Snapshot PC
-Logon as Local Administrator
-Launch Wise Package Studio
-Click Tools tab
-Launch Windows Installer Editor
-File menu -> Open
-Browse to the target MSI file and open it

-Click No
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-Click Yes

-Set the New Source Directory:  W:\WiseSharePoint\Projects\MyApp\MyApp\FILES
-File Sources: click Next

-Click Finish
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WPS: How to create a MSI package from a setup.exe using Projects
This is the preferred method because it types in fields automatically for you. This feature alone is
useful since having to run SetupCapture more than once is not uncommon. The WSI file it creates
has relative file paths so that you don’t need to install the package just to do small change. This
process also update the “Workbench Database”, this makes it possible for others people can also
check to see how one package or another is progressing.

Document each step used to create the package. 
The purpose to document is to facilitate the recreation the package in case of an error (major or
minor), to facilitate the packaging of future versions of the same package and helps to build other
packages in case a special fix or tweak was used to get this package to work. If you can, use the
documentation from a previous application that you packaged as a base and modify accordingly (or
use the one from my tutorial). What follows is in fact a generalized version of one of those
documents. Please note however that every package is different.
 I prefer to create these documents using WordPad since it is already installed in Windows and
does not use tones of files. I use a filename that matches with the WSI filename. (MyApplication-
v123.WSI => MyApplication-v123.wri) Using the WRI extension ensures that WordPad will
always be used to edit the document even when MS-Word is installed.

If you notice a step that is always done on all packages, the MSI template should then be upgraded
with those changes so that they are never forgotten and not explicitly documented in all package
documents.

If you must skimp on documentation, at least document anything unusual that you may have
done in a package.

Create an entry for the Project
The first thing you must do is setup the project. You can use the Packaging server or the Snapshot
PC to do this.
-Launch Wise Package Studio

-Edit menu => Project  (Or click the Project setup  icon on the toolbar)

-From the toolbar, click on the add  icon
-Enter the name of the MSI file that you want to get minus the MSI extension.
-What follows is an example for Sun_JVM_v1_4_2_03

Notice that Sun_JVM_v1_4_2_03 is used only in Project name, application Name, Package name
and the filename. For the Vendor Package click the … button and browse to the original setup.exe
that you want to repackage.  I created a folder below the Sun_JVM_v1_4_2_03 folder and called
it Original Files. That way I know exactly what I used to create the package. The process of
setting up a project would usually create the Sun_JVM_v1_4_2_03 project folder. 
-Click Close

Capturing the Setup Process
-Restore the Clean Image on the Snapshot PC (It should already have the Wise Package Studio or
its Client installed with drive mapping to the Wise SharePoint ). For a more step by step
approach, see the tutorial.
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On the Snapshot PC
-Logon as Local Administrator
-Launch Wise Package Studio
-In the Workbench, click Projects tab
-Select the active Project.

-Click on Run beside Create Package to launch SetupCapture
-Click Ok; click Next
-Capture Methodology: leave it at Snapshot but uncheck SmartMonitor. Click Next
-Begin installation capture; Click Next to take initial snapshot of system
-Click Execute to launch the setup.exe (required for SmartMonitor to work if you do use it)

-Follow the menus for the setup.exe.
-Make all changes required to make the program work.
-Document anything that is not default
-If possible do not run the application since some self-configure on first run

-Come back to SetupCapture window when done
-Click Next
-Click Next to take second snapshot of system
-Review SetupCapture Inclusions; change if necessary and click Next

-To exclude a file select the file and click Exclude

Note: The Exclude Globally adds the exclusion to the WisePSSC.ini file for
all future snapshots. Careful!

-Click Next
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-Review SetupCapture Exclusions; if necessary and click Next
-To include a file select the file and click Include

-At the finish window
-Fix the Name of the application to include the version (ie AppName to AppName 3.0)

If you plan to deploy the MSI Package using GPOs, add the Version to the
name or else 2 versions of the same application will display the same name.

-Make sure the Default Folder is correct. 
(It’s usually the main folder for that application located under Program Files)

-Click Finish

-If you get the Files in Merge Modules window similar to this:
Gotcha: If you plan to use the

“Application Isolation” feature
and the DLL or OCX you want
to isolate is part of one of the
Merge Modules, you will not
have that DLL (or OCX)
available to use the “Application
Isolation” feature. Unselect the
Merge Module that contains that
DLL (or OCX) and leaves the
rest of the Merge Modules alone.

-Click Ok
-If required, download any missing Merge Modules.

-If the download fails you can try again but do it while you are still here in SetupCapture.
-Save the WSI
At this point WPS will now copy all the files that make up the package to the Wise Source Point
and make all references to then in the WSI file relative. This way you will not have to install the
application just to make a simple change.
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Editing the package 
-Click Projects tab
-Click on Run beside Edit Package

In the Installation Expert view:
In Product Definition section select Add/Remove Programs

-Click Browse to add the icon for the application 

NOTE: Fancy icons are optional in Add/Remove Programs.  Otherwise a
generic Icon is used in the Add/Remove Programs applet on the target PC.

In Feature Details section select Files
-Remove or add files that were missed during the SetupCapture process
Save WSI package

Go to the Setup Editor view:
-Click the Tables tab

-Go to Property table
-In right panel, right-click New -> New Row

-Click OK to acknowledge the warning
-In the property column enter: ROOTDRIVE 

Gotcha: Properties in UPPERCASE
are Public properties in MSI. Also
ROOTDRIVE and ROOTDRIVE_
with a space at the end are different.

-In the Value column enter: C:\

NOTE: This will prevent MSI to install on the drive with most free space and
guaranty that it will always install on the C: drive of the Target PC.

-In right panel, right-click New -> New Row 
-Click OK to acknowledge the warning

-In the property column enter: ALLUSERS (In UPPERCASE, no trailing spaces)
-In the Value column enter: 1

NOTE: This will force the application to install for all users and use the “All Users
Profile”. This is preferable so that different users on the same machine don’t have to
have the application reinstalled for each new user.

Save WSI package
-Click Compile to create new MSI package
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WPS: How to edit an existing package using projects
Here the source files exist outside of the MSI file and are referred to using a relative path. This
means that you can edit the WSI file and recompile without having to install the application. All
you need is a PC with Wise Package Studio or its Client (aka WPSClient.exe) installed.

-Click Projects tab
-Click on Run beside Edit Package 
-Do your changes
-Save the WSI.
-Click Compile to create an updated MSI file.

NOTE: you don’t have to use the “projects” tab just to edit your package. You can, at this
point, just double click on the WSI and go from there. The only difference is that the little box
in the project for “editing” the package will not be checked automatically. You can do that
manually if you have a “big brother” work environment…

WPS: How to add file to an existing package MSI with relative paths
Here the source files exist in the SharePoint  and they are referred to using a relative file paths. 
This means that you can edit the WSI file and recompile without having to install the application.

Gotcha: If you add files, you must copy them to the proper project sub-folder in the
SharePoint . If you copy the new files to the C: drive and add them from there instead,
those new files STAY on the C: drive.

Let’s says you need to add a file called NewFile.EXE into the package for AppName-v123 so that
it ends up as C:\Program Files\AppName\NewFile.EXE. To do this:
-Copy the file to 
WiseSharePoint\Projects\AppName-v123\Program Files\AppName\NewFile.EXE
in the SharePoint . (You might have to create folders if they don’t already exists)

Open the WSI file
In the Installation Expert view:
In Feature Details section select Files
-Add those files by browsing to them in the SharePoint , NOT on the C: drive
-Click the Add File button
Wise Package Studio will add the file to the proper folder in the package.

-Save WSI package
-Click Compile to create new MSI package

Gotcha: In older version of Wise Package Studio, you had to go inside the WSI and tweak
the source file paths to make them relative. 

(NOTE: this will overwrite the previous WSI and MSI files unless you made copies)
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WPS: How to convert a Package to relative Source paths
When you capture an application with the defaults, the resulting WSI needs to have the source files
installed on the clean PC for WPS to build the MSI file. This is an annoying limitation when you
need to do a quick change to the package and the application is not already installed on the Clean
PC, worse when the CleanPC is not available at all. (NOTE: In WPS 4.x and up, you can create a
package with relative source paths during SetupCapture.)

In the Tools menu of WPS, in Convert Source Paths, there is a Change all paths to relative
button but it doesn't work with [Path Variables] (which is used by defaults in WPS captured
packages). (Wise has confirmed that this is a bug!)

Workaround
Step 1- Extract the source files from the MSI
-Start the Windows Installer Editor
-Browse to the MSI file of the Application, open

-Click Yes
-For the New Source Directory, make it a sub-directory (lets call it Files) where the MSI and WSI
files are.
(ie.: if the MSI and WSI files are in W:\WiseSharePoint\Projects\MyApp, Make the New Source
Directory W:\WiseSharePoint\Projects\MyApp\files )
-This will create another WSI file in the Files folder. Delete it to prevent confusion.

Step2 - Modify source paths the original WSI
-Open the WSI into Windows Installer Editor
-In the Tools menu, select Convert Source Paths
-Select a path (a high-level path if possible)

-click the Change Selected Path... button
-Edit the paths to start with .\files\ 

-Replace [ProgramFiles] with .\files\Program Files\
-Replace [WindowsFolder] with .\files\WINDOWS\
-Replace [SystemFolder] with .\files\WINDOWS\System32\
-And so on

-Select Relative Paths from the Path Type drop-down list. 
(*This MAY convert all directories you add subsequently to relative paths.)
-Click OK 

-Save the updated WSI file.
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*The reason that I put in “MAY convert” is because I always have to fix the source path after
I add a file. It is probably related to the same bug. 

Add a file located on C:\Windows it will convert it to a path starting with [WindowsFolder]
Add a file located in the Wise SharePoint  in the existing tree structure, it will convert it to a
path starting with [WiseShare Point] instead of .\files\Windows
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How to test packages (Testing scenarios)
Using the Testing PC in all scenarios:

Test install on a PC with Clean image
This is to make sure that the package is complete by itself. If you are missing a certain file in the
package (ie. you deleted it by accident) it will be obvious. 

Test install on a PC with your “corporate image”
Here you install your application along with the other application that will normally be on a
workstation in your environment. This to make sure that the package can function with the rest of
the applications that you will have. If it fails, then the package must compensate but still be
complete. Sometimes it’s another package’s fault. 

Test installing the application as an administrator then test using a different administrator
Install the application but don’t launch it at all. Logout and use a different user. If it doesn't work
as expected then the package does not populate the profile and/or Hive for alternate users.
Sometimes this is intentional due to "Per User" licensing vs. "Per Machine" licensing. Most
software is licensed on a "Per Machine" basis.

NOTE: This is when many commercial packages fail. Most developers assume that the users of
their application will be the same user that installed it. This is why some applications work using
your account but not your wife's because you installed the application using your account.

Test installing the application as an administrator but test with a Restricted User
Install the application but don’t launch it at all. Logout and use a user with restricted permissions.
The application should only populate the user’s profile and Hive; otherwise you need to ease up on
the permissions on the C: drive and/or Registry. 

NOTE: This is where most commercial packages fail. Most developers assume that the users of
their application will also have full access to the machine, all the time. In businesses, however,
they lock down the PCs to prevent tampering which is supposed to reduce services calls. This test
is critical in those environments.

Test removing the application
This is to see how clean the removal of the package:
-Logon as an Administrative User
-Uninstall the MSI package
-Test to make sure the App does not work anymore and no traces remain.

NOTE: Some applications will leave folders that contain user created files and/or configuration
files. It is usually preferred that the configuration files are kept for a future re-installation or
upgrade without having to fully configure the new product. In the times when you don’t want this,
some developers end-up creating a “Cleanup Package” whose sole purpose in life is to remove
traces of another application. It not a bad idea since even MS have one for their Office. Too bad
this functionality is not part of the MSI spec… (HINT HINT MS ;)  )

Any other tests that you can think of would have to revolve around what the package does.
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WPS: How to configure the MSI template (optional)
When you create an MSI package, Wise Package Studio takes an empty template MSI and adds to
it. This step reduces the amount of steps repeated in all packages during the editing process. You
can skip this and fix it later.
-Launch WPS
-Select the Projects tab
-Select the Initial workbench setup as the active project
-Click Run for Customize Windows Installer Template 

What follows are only suggestions. It’s all up to you.
-Go to the Setup Editor view: (one of the three tabs at the bottom)

-Click the Product tab
-Go to Launch Conditions
-In right panel, right-click New -> Launch Conditions

-Click Build button
-In the Fields column select Property
-In the Values column select Privileged

NOTE: According to Wise article 665, this
should be AdminUser (I'm hard headed though!)

-Click Paste and Ok
-In message text: 
You do not have sufficient privileges to complete this installation
for all users of the machine.  Logon as administrator and retry
this installation.

NOTE: Even though the “Package validation” tool will tell you 255
Characters are the maximum, larger messages still work fine.

-Click Ok
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-Go to Launch Conditions
-In right panel, right-click New -> Launch Conditions

-In condition enter: MsiNTProductType = 1
-In message text: 
This package was designed to NOT allow installation on Servers and
Domain servers as a precaution. Please refer to your MSI packaging
team for an alternative. 

-Click Ok
-Click the Tables tab

-Go to Property table
-In right panel, right-click New -> New Row

-Click OK to acknowledge the warning
-In the property column enter: ROOTDRIVE

Gotcha: Properties in UPPERCASE
are Public properties in MSI. Also
ROOTDRIVE and ROOTDRIVE_
with a space at the end are different.

-In the Value column enter: C:\
(This will prevent MSI to install on the drive with most free space)
-In right panel, right-click New -> New Row 

-Click OK to acknowledge the warning
-In the property column enter: ALLUSERS (In UPPERCASE, no trailing spaces)
-In the Value column enter: 1

-Save and exit (Do NOT compile!)
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WPS: How to configure SetupCapture’s Exclusion list
As you use higher versions of Wise Package Studio, the need to make these changes diminishes
since many of these exclusions as then standard. In fact, since WPS 4.5x for application for XP, I
don’t bother doing this procedure since Wise has done this so well. Until Microsoft make another
major OS upgrade beyond XP, I wouldn’t bother. This is currently big time optional.

NOTE: You can have many different exclusion lists depending on your situation. (i.e. One for
English apps, one for French apps…) 

On a Clean PC (ie the Snapshot PC)
-Launch WPS; click on the Tools tab
-Select SetupCapture Configuration 

Gotcha: If you rename the file here you effectively create a new file from SCRATCH and
all exclusions that came with WPS will not be included! Workaround: Copy the existing
WisePSSC.INI file to the new name then select it here.

-Configuration file location; click Next 
-General settings; click Next 
-Directory to watch; click Next 
-Build exclusion list; select Automatically build exclusion list ; click Next 
-Minimize all Wise applications (SetupCapture Configuration cannot be minimized); click Next
-Launch Notepad, WordPad, Paint, Regedit, Play a wav file, Browse the Internet

Gotcha: If you have already run these applications in the image then the registry entries
are already created and this process will not pickup much.

-Leave SetupCapture Configuration running and Reboot
-The SetupCapture Configuration window comes back on; click Next
-Now click Next to record what to ignore during packaging
-File exclusions; review and click Next
-Registry exclusions; review and click Next
-VirtualOS, click Next
-Copy C:\WINNT\WisePSSC.ini to the Wise SharePoint  and rename appropriately.

-Edit the resulting WisePSSC.ini file with SetupCapture Configuration. When reviewing, the
new entries have Question marks in front so that you can decide if you want to add them or not.

-Convert file exclusions into a folder exclusion for obvious folders like:
C:\WINDOWS\Prefetch, local settings\temp, IE cache, etc

-In the registry convert the following to <ignore entire subtree> and remove redundant entries:
-in HKCU hive:
-\SessionInformation (ProgramCount= 3 of programs running during capture time)
-\Software\Microsoft\Windows\CurrentVersion\Applets\Wordpad (caused by using WordPad)
-\Software\Microsoft\Windows\CurrentVersion\Applets\Paint (caused by using Paint)
-\Software\Microsoft\Windows\CurrentVersion\Explorer\UserAssist (caused by Explorer)
-\Software\Microsoft\Windows\CurrentVersion\Explorer\RunMRU
-\Software\Microsoft\MediaPlayer
-\Software\Microsoft\Windows\CurrentVersion\Explorer\Discardable (Explorer browsing)
-\Software\Microsoft\Windows\CurrentVersion\Explorer\Streams (Explorer browsing)
-\Software\Microsoft\Windows\CurrentVersion\Explorer\StreamMRU (Explorer browsing)
-\Software\Microsoft\Windows\CurrentVersion\Explorer\BitBucket (Explorer browsing)
-\Software\Microsoft\Windows\ShellNoRoam (Explorer browsing)

-in HKLM hive
-Software\Microsoft\EventSystem (caused by event viewer entries being added)
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WPS: How to create a transform (.MST files)
On the Snapshot PC
-Logon as Local Administrator 
-Launch WPS
-Click Tools tab
-Launch InstallTailor

Browse to the MSI package that you want to create the transform for
-Click Next
-It now launches the MSI

-Follow the menus to install the application until the end

-Capture complete: click Ok
-Check the Edit this transform file using Windows Installer Editor box
-Click Finish
-You are now inside the Windows Installer Editor tool
-Make the changes that you require and click Compile
-Transform Details: Don’t select anything (unless you know better) and click OK.
-The MST file is created in the same folder as the MSI.

Note: Once you have the MST file created, you can use the Windows Installer Editor to make more
changes to the MST at a later time. 
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all the motions. It is recording what you choosing for defaults.

NOTE: for InstallTailor to work, the MSI package must NOT already be installed on
the machine.



WPS: How to isolate a .DLL with an .EXE
"DLL Isolation" is used when your application needs a specific version of a shared DLL for it to
work. This is how you deal with needing 2 versions of the same DLL on the same machine. What
it does is copy the DLL into the same folder as the EXE that needs it. The caveat is that you can
only have one version of the DLL loaded in memory at a time. (ie: App A loads DLL version 1 and
then App B tries to load DLL version 2 but can't. App B ends up hanging or blowing up...)  This is
meant as a band-aid until you update one application or the other.

Taken from WIFI.PDF
1. On the Components tab in Setup Editor, right-click the .DLL you want to isolate.
2. From the right-click menu, select New > Isolated Component. The Isolated Component

Details dialog appears where you pick a file for isolation from the feature that contains the
component.

   
 If the key path for the current component is not an .EXE, then the drop-down list

shows all .EXEs in the containing feature that are key paths of .DLL files.
 If the key path for the current component is an .EXE, then the drop-down list shows

all files from the containing feature that are key paths other than the current
component.

3. From the Associated File drop-down list, select the .EXE you want to assign to this .DLL.
4. Click OK.

 Gotcha: If your package uses Merge Modules and the DLL you are trying to isolate is part
of one of these Merge Modules, then you will NOT BE ABLE TO ISOLATE THE DLL. Repackage
and exclude the particular Merge Module that contains your DLL and try again.

WPS: Editing MSTs or MSIs from Microsoft products.
Don't bother. Microsoft has special tools to customize the installation of their Office products. The
resulting MST files are in general not to be messed with. They have so many customizations that if
you try to edit an MST file created by Microsoft's Office Resource Kit (ORK) with WPS, the
resulting MST file is not usable. (Visio, Project, Access should be included here)

I have seen a MS Knowledge base article (Q224334) explaining how to use ORCA to edit a MS
Office 2000 MST file to embed the Serial number but that's it.

There are some exceptions for the small dinky MSI that MS didn't bother to over-enhance like
utilities and viewsers. 
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WPS: Creating MSIs from scratch (no SetupCapture)

Sometimes you want to create some dinky MSI and don't see the point to go through the
SetupCapture route. You should still create a blank WSI and go from there. 

 Gotcha: The absolute minimum that an MSI package must do is
copy one file. If you create an MSI package that just plugs the registry or
run a custom action, MSIEXEC will not like it and give you an error. The
workaround is to make it copy a bogus file to the temp directory (the user's
or the one in C:\windows\temp, it doesn't matter!)

 NOTE : In WPS 5.1, however, WPS doesn't complain about this. If you don't
add a file and try to run the MSI, you'll get a 2235 runtime error. (Something
about there not being any components...)

 Gotcha: If you have only one file in the package, it becomes
the KeyPath
If this file is a bogus file in C:\windows\temp, when the file is deleted
the MSI will try to self-heal and recreate it (Which start a vicious
cycle).  If you want to prevent this, you'll have to create a key in the
registry and make it the KeyPath for the package.

 NOTE : If you want, you can also create a project entry in the Workbench but WPS has no
"Create from scratch for Windows Installer" process. YOU have to create the blank WSI file in the
right place in the SharePoint for the links to work right.

Let's say we want to create Widget_V1.MSI to copy a file and plug the registry.

-Launch Wise Package Studio
-Click Tools tab
-Launch Windows Installer Editor

 Gotcha: Unless you haven't done anything with WPS, launching
Windows Installer Editor (aka WIE) straight like this will load the previous
WSI/MSI file that was opened with WIE. We MUST create a new file or else
your blank package will look, err, very familiar to past work. ;)

-Select File menu -> New 
-Click Ok

-Select File menu -> Save As
-Browse to the SharePoint to the proper folder. (ie Widget_V1)
-Change the name from Untitled.wsi to Widget_V1.WSI
-Click Save

-NOW we have a clean slate. 
Now we want to add a file and have it use a "Relative Source Path". 
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In the SharePoint , under the proper project folder, create the folders and copy the file(s) you need
to add the the package. Ie:
Let's say you want the package to install C:\Program Files\widget\widget.exe
you create \Program Files\widget  folders in the Sharepoint like this:

Go back to Windows Installer Editor
-In the top window, browse the SharePoint to locate and add widget.exe
-WPS adds the file but creates an absolute source path to the file starting with the
[WiseProjectPath] variable. ( This is from Tools menu -> Convert Source Paths)
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 “Relative Source Path” is used to make it possible to compile the MSI without having to
copy the file(s) to the local PC. If you just browse the C: drive, find your file(s) and click Add,
that file would have to be there, on the C: drive every time you compile the MSI because WPS
adds all files with an Absolute Path by default. Relative Source Paths solves this. The problem
is that Wise Package Studio does not have an easy way to add files to a package and use
Relative Source Paths in one shot. 

The other good about using “Relative Source Paths” is that if you move the contents of project
folder or rename the project folder, you'll will still be able to compile the MSI. If you stay with
the default Absolute Source Path, you'll have to go to Change Source Paths in the tools menu
to change the Source Paths. And that’s IF you copied the files to the network!



-Select Tools menu, Change Source Paths
 Gotcha: You can click the Change All Paths to Relative button till you

are blue in the face and it won't work! The functionality behind the button
cannot handle “Wise Path Variable” in the source Paths. This is a big deal
since Wise Package Studio v3.x to 5.1 to use “Wise Path Variable” by
default! (Please ask Wise to fix this since my bug report was ignored.)

Even if you change the “Path Type” thing at the bottom to Relative Paths,
WPS still plugs the “Wise Path Variable”!

-Click Change Selected Path.. button.
-Change [WiseProjectPath]Widget_V1\Program Files\widget  to .\Program Files\widget
NOTE:  The .\ is the location for the .WSI file.

-Now add the registry entry that you want. Be it by importing a .reg file or by adding from the PC's
own registry.

-Click Compile
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Looking for ICE errors
Using ORCA
Most of my peers use MS’ ORCA to check for ICE errors. Though Wise Package Studio does
provide ICE checking, it some times misleads you (see “Using WPS”).Get it here
http://msdn.microsoft.com/library/default.asp?url=/library/en-us/msi/setup/windows_installer_development_tools.asp

ICE errors are NOT Wise’s fault, it’s just MSI has rules and some applications break them. If
you want proof, check for ICE errors on Microsoft Office and wait for 5 minutes. The irony here is
the Office arm of Microsoft is responsible for inventing MSI.

On the testing PC
-Install ORCA
-In the SharePoint, browse to your MSI file
-Right-click on it and select Edit
-in the Tools menu select Validate

-Un-check the Show “INFO” Messages box and click Go.
-Now wait for about a minute.
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-Click on the Copy Results button and paste into a text file and click Close
-Keep ORCA open if you want as it can help for troubleshooting. Do remember to close ORCA to
compile new MSIs from WPS or else ORCA keeps the MSI file open and WPS can’t touch it.

Using Wise Package Studio
Earlier in ICE error checking with ORCA I mentioned that Wise Package Studio had means to
detect ICE errors and errors in general.  To look for errors in Setup Editor click  or  press F4. 

The problem is that Wise Package Studio always report this error:

And this is after we have resolved all the ICE errors that ORCA complained about. 
If you try to fix this you'll break the package. 

In Wise's defence, however, the error checking function did help me once to resolve a problem that
was preventing me to compile an MSI.
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How to fix ICE Errors
If you are willing to do this then you better know what you are doing. There are errors, warnings
and information messages. First, don't bother with the the warnings and info messages. Here are
some hints (and I do stress hints) as to what to do with specific ICE error messages. If you go into
my tutorial you'll see that some ICE errors can disappear by fixing other ICE errors.  With practise,
you'll be able to feel-your-way to resolve most if not all ICE errors. 

The SDK also hints how to fix these ICE errors. Just click the SDK icon   and search like
this:  ICE38     
not:  ICE 38

ICE02
(Taken from Wise newsgroups)
> Registry: 'primarykey' cannot be the key registry key for
> Component: 'PerMachine'. The RegKey belongs to
> Component: 'notes.exe' http://dartools/iceman/ice02.html
> Component KeyPath PerMachine
> Evaluation: ICE02

To fix this, go to the Setup Editor page and the Components tab. Browse down to the component
named "PerMachine" (which might even be highlighted in red) and right-click, choose "Details".
Under the "Key Path Type:" drop-down, choose "File Key Path", and then choose any file from the
"File Key Path:" drop-down just below it.

> The directory Lotus_Applications is in the user profile but is not listed in the RemoveFile table.
> http://dartools/iceman/ice64.html Directory Directory
> Lotus_Applications
> Evaluation: ICE64

This one is simply what it says... During the install, the "Lotus Applications" folder is created
in the Start Menu. If you want to delete it during the Uninstall, add it to the RemoveFile table.
(Follow the examples in the RemoveFile table and the directions in the MSI Help.)

ICE33
ICE33 warnings are next to impossible to fix. The warning message hints to use the ProgId and
Class tables. Discussing with other peers reveals that any attempt to fix ICE33 warnings are futile
and will break the package.

For John_McFadyen, ICE33 warnings are not so impossible to fix:
When you have an ICE33 error, you can find the relevant inprocsvr32 key for that error. Then trace
it back to the DLL which owns the COM registration. 

Remove the DLL from the package, register it on the local machine [using regsvr32] then import it
back into the package. (in some cases you may wish to keep the component code) which is another
step. 

On import, Wise will correctly pick up the ProgId/Class details. You may be required to select
rescan COM data from the components view and you will find Wise correctly allocates the COM
tables. The [ICE Error causing] registry data can then be safely removed. 
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ICE38
ICE38 states that any component that installs to the user profile must have a registry key as its
KeyPath. You have 2 ways to fix this:
-Create a bogus entries in registry in the HKCU and make them part of the component causing the
error. 
-Steal (aka move) a HKCU entry in registry from the CurrentUser component to the component
causing the error.
Look in the Tutorial in the Fixing ICE errors section for more details on how to do the stealing
method. For a straight answer ignore the greyed out sections in the tutorial. 

ICE57
An ICE57 error means that a component has both User (hive entries or profile files) and Machine
(hive entries or files). That’s a no-no according to the MSI SDK (click ). You have to
determine if the component is more of a User thing versus a Machine thing. (This is the feeling-
your-way part I was talking about) 
Usually, I break the stalemate by un-encoding the registry value. Look into the Tutorial in the
Fixing ICE errors section for a hint on how to resolve this one.

ICE64
ICE64 errors are directories in the user profile that will not be removed correctly (read “at all”)
during uninstall or roaming user scenarios. To fix this you usually create a row for each folder in
the RemoveFile table. Look into the Tutorial in the Fixing ICE errors section for a hint on how
to resolve this one.

Other situation: 
ICE64 ERROR The directory iPass is in the user profile but is not listed in the
RemoveFile table.
In this one package I got an ICE 64 error but the “offending” directory does not exist in the user
profile. It's in the All Users profile.
Upon removing the package, however, the iPass folder does get removed from the All Users
profile so this is purely a cosmetic issue. Here ORCA even helps me find which iPass directory we
are talking about:

The RemoveFile table.

-FileKey is anything. It’s just an identifying label. Let’s go with dir1
-Component_ usually, is the component that created the iPass folder to begin with. No component
seams to be explicitly creating the folder. And unlike the tutorial, this package has no
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CreateFolder component that I could use. So I'll used CurrentUser. (Don't try to create a bogus
Component for this. I tried and it created another ICE Error.)
-FileName needs to be blank to specify a directory and not a file.
-DirProperty is for a property that contains the full path to the iPass folder. The SDK says that this
must be a property in the Directory table. So let’s look it up.
Open the Directory table and sort on the Directory_Parent column:

By using the name in the Directory column (it has the key icon), it seems to be iPass ( NOTE:
this is a coincidence. Noticed that there are 2 iPass directories mentioned in the DefaultDir
column. One has a Directory_Parent ProgramMenuFolder and the other it's ProgramFilesFolder.
ProgramFilesFolder means C:\Program Files so we know we know we want the other one.)

-InstallMode determines when the file is removed. A setting of 2 means to remove it at package
removal time. (These details are in the SDK, click , search for RemoveFile)
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Packaging Tricks and traps
How to have conditional changes inside an MSI
Issue:  You want to perform a change (copy a file, plug the registry, etc) but you want to test for 
a condition before you apply it. 
Solutions:
Method 1-Use Conditional Features:  (Best solution)
-Go to the Installation Expert view
-In Project Definition click on Features
-Browse to where you want to create the new feature and click Add Condition button

-Add in your condition in the Condition field and click OK.

NOTE: In our example, we are using an environment variable. The "~=" means non Case-
insensitive compare. (BTW: OS_LANG doesn't exist by default in Windows)
We could also test a property like this: MYPROP = “ABC”. This property can also be set by a
System Search to test if a file or registry setting exists or not.
-To add a file for that condition, go into the files node and select the newly created feature.

-Now add the files that you need for that condition.
-You should be able to figure out the rest for registry entries, etc.
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Method 2- Use Custom Actions in MSI script. Here you have many options but beware that
none of them will be part of an MSI rollback. You can use:

-A DOS command for the simple stuff.
-A VBS script for more elaborate stuff (good for portability between MSI packagers)
-Another MSI package
-An EXE (ie. A SMS installer package)
-WiseScript

Since you don’t want these files to be left after they run you want to add them to your package as a 
resource.
-Place these files in the Project folder for your target package.
-In the target package: 
Go to the MSI Script view:
-Select the Execute Deferred page
-Just before the CreateFolders action add a custom action that ends with From Installation

ie: Call VBScript From Installation
Execute Program From Installation
Install MSI From Installation

-Enter a name for your Custom Action (Anything, it's just a cute label)
-Browse to your file that is located in the Project folder for your target package
-Click Ok 

One package or two?
Issue: I want a package that can install as French or English automatically.
Solutions:
Method 1-Create one package with 2 features, one feature for each language. Then use
Conditional Features to detect a condition to automatically choose the language. (The best way)
-Go to the Installation Expert view
-In Project Definition click on Features
 
Method 2-Create two packages and assign accordingly. (If bandwidth is a concern this is best way)

Method 3-Create one package and use Custom Actions that install files and registry settings
differently depending on the Language. The catch is that anything done in Custom Actions
cannot take advantage of the self-healing and rollback features of MSI.  

Method 4-Create one big MSI package and use Custom Actions that in-turn launch one of 2 other
MSI packages contained within the big package depending on the Language. There is a Custom
action called Install MSI from Installation that will do just that. Again, the catch is that
anything done in Custom Actions cannot take advantage of the self-healing and rollback
features of MSI. Launching an MSI from another causes the child MSI not being able to rollback. 

Note: You can use MSI Script but you must script so that your changes work during an
install and an uninstall.
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How to detect the System Language on the destination PC?
Use the SystemLanguageID property. 

In the WSI package:
Go to the Setup Editor view:
-Click the Product tab

-Go to Launch Conditions
-In right panel, right-click New -> Launch Conditions

-Click Build button
-Enter SystemLanguageID = 1033 (1033 is English_United_States)
-Click Paste and Ok

-In message text: 
This package was designed to install only on system of a specific
Language. Contact your administrator.
-Click Ok 

Gotcha: One pitfall that you may fall into is that this uses Local IDs. This means that one
English system may have a different Local ID than another depending on the consistency of your
target PCs even though they are all English.

To get a listing of SystemLanguageIDs (aka LCIDs) go to
http://www.microsoft.com/globaldev/reference/win2k/setup/lcid.mspx

How to prevent MSIs from installing on a server
Use the MsiNTProductType Property to test what type of machine you are using.

Value Meaning
1 Windows 2000 Professional and later
2 Windows 2000 domain controller and later
3 Windows 2000 Server and later

To do this in a package:
Go to the Setup Editor view:
-Click the Product tab

-Go to Launch Conditions
-In right panel, right-click New -> Launch Conditions

-In condition enter: MsiNTProductType = 1
-In message text: 

This package was designed to NOT allow installation on Servers and Domain
servers as a precaution. Please refer to you MSI packaging team for
workarounds. 

-Click Ok

Page numbers



How do I get the property of the MSI filename
(Taken from Wise newsgroups)
From: "Tech_Spec_3" <standardATNOSPAMwise.com>
Subject: Re: How do I get the property of the MSI filename.
Date: Monday, July 08, 2002 6:00 PM

If you wish to get the full path and filename to the MSI file that was run you can use the
OriginalDatabase property.  I could not find this property document in the SDK but I have used it
effectively with consistent results in the past.  Also, there is a DATABASE property that holds the
full path and filename to the MSI file stored by Windows Installer in the temp directory where it
is actually run from.

If you wish to know which transforms have been applied you can use the TRANSFORMS
property, which is documented in the Windows Installer SDK.  This property will contain a semi-
colon delimited list of transforms that have been applied to the MSI.
-- 
Mike
Technical Support Specialist
Wise Solutions, Inc.

NOTE: If you need to extract the MSI's filename from the full path, you'll have to use VBS or
WiseScript to do it for you. MSI has nothing to parse strings!

How to register a DLL with a command

How to register a DLL within Wise Package Studio

Should I register a DLL during or after SetupCapture?

To register a DLL with a command line change to the directory where your DLL is and run:
regsvr32 mydll.dll

Please note, however, that if you copy that DLL into C:\Windows\System , Windows will
register the DLL automatically.

To un-register a DLL with a command line use the following:
regsvr32 /u mydll.dll

regsvr32 /? will give you more switches

You can also make a DLL self-register within WPS like this:
While in Installation Expert in Feature Details section 

-Select Files and browse for the DLL.
-Right-click on it and select Details
-Click on the Self-Registration tab
-Select Unordered 
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This will work and make for a smaller MSI than registering the DLL during SetupCapture but
looking up the SelfReg table in the SDK (click ) it says that it is not Strongly not
recommended:

It is strongly recommended that installation package authors not use
self-registration. Instead they should register modules by authoring one
or more of the other tables provided by the installer for this purpose. See
Registry Tables Group. Many of the benefits of having a central installer
service are lost with self-registration because self-registration routines
tend to hide critical configuration information. 

The SDK then proceed giving 6+ examples of why not to use Self-registration.

Possible Gotcha: I once tried used both methods for the installation of a particular DLL.
Both methods worked but both seemed to register the DLL twice according to the SharedDLLs
key. (see HKLM\SOFTWARE\Microsoft\Windows\CurrentVersion\SharedDLLs)

This meant that upon removal of the MSI package, the DLL would be left on the disk since the
count is not 0 and thinks that more than one application use the same DLL.  My solution was
to let the MSI copy the file but use the regsvr32 to register and unregister inside MSI script.
My peers told me, however, that it must be a quirk for that particular DLL since they've
never seen such a stupid thing.
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How to set a Property using an Environment Variable

How to set a Property based of the value of another Property

Custom Action Type 51

What the Frel is a Custom Action Type?
Custom Action Types are the building blocks of MSI. The ones used most often appear in the
Actions column of MSI Script tab inside the Windows Installer Editor. Once in a while you might
want an Action that is not in the list. This is where you must add them manually as shown below.

You cannot set a property based of the value of another property. This is necessary to prevent
creating circular references in the Property table (aka which gets its value first). Instead, you can
set one property based on another by using a Custom Action Type 51. (It's in the SDK, click )
This custom action sets a property from a formatted text string. 
To affect a property used in a condition on a component or feature, the custom action must come
before the CostFinalize action in the action sequence.

The Wise KB Article #1156 and Wise KB Article #1957 hint as to how to do it but the feature to
add new a Custom Action as described is broken in WPS4.62 and WPS5.1! (Specifically the
Right-click on All Custom Actions, and select New --> Custom Action doesn't work.) Here is the
workaround:

Example:  Settings a Property to the value of an Environment Variable
Go to the Setup Editor view:
-Click the Tables tab
-Add a row to the CustomAction Table manually 

Go to the MSI Script view:
-Actions tab --> All Custom Actions
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-Select the Custom Action that we created in the tables.

-Double-click on it

By using the SDK (look up "Custom Action Type 51") and the snapshot above, we deduce:
-Property (aka source in the SDK) is the Property we want to set.
-Property Value (aka the target in the SDK) is the string that we use to set it with.
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To be based on another MSI Property, set the Property Value string to [OTHERPROPERTY]
You can also combine 2 Properties together like this {[PROP1][PROP2]}
There are a few other things you can put here by looking up FORMATTED in the SDK. 

One thing you cannot do is parse strings. (ie extract a portion of the value contained in
another Property).  I hope MS makes a new Custom Action in MSI 3.0 for this. One way
this can be done is with a VBS script or WiseScript. 

-Click on the Location tab

-Uncheck the No Sequence box
-Select CostFinalize and click the Add button
-Make sure that this action occurs before the CostFinalize action. (use the Move Up and
Move Down button if necessary)

-Click Ok and we are done!
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How to parse strings in MSI

How to manipulate the contents of Properties

How to pass Property values to VBS Scripts or WiseScripts

MSI Script has nothing to manipulate character strings (ie LEFT( ), RIGHT( ), MID( ), etc). To do
this we must use a VBS script or WiseScript. To do either, we must call the scripts from MSI
Script. 

The hard thing is determining where in MSI script to do this. This all depends on the Property you
are trying to use. If you try to use a property that is set after the Custom Action you added, you
won't get what you're expecting. 

Sometimes you can get into situations where the Property that you need gets its value too late
in the Sequence. In those situations, you can change the sequence order to make the Property
get its value sooner in the Sequence. This, however, is a last resort thing and you should get
help from the newsgroups or Wise tech support.

Parsing with VBS script
(With help from Wise KB Article #1548)
For an example, let's try to extract the name of MSI file from the OriginalDatabase property. The
OriginalDatabase property give us the name of the MSI file but it includes the full path, we want
to parse for the MSI file name only.

-Go to the MSI Script view:
-Select the Execute Immediate page
-Place it after the CostFinalize action (This is usually safe since most properties are now defined)
-In the left column select Call VBScript from Embedded code  

-Custom Action Name: MrParseIT (This is just a cutesy label, it's whatever you want)
-Enter the VBScript to execute:

'based on the InstrRev entry in Script56.CHM
Dim MyString, SearchChar, MyPos, Resultstr

'Read from windows installer property.
SearchString = Session.Property("OriginalDatabase")
SearchChar = "\"  ' Search for "\".

'edit SearchString
MyPos = InstrRev(SearchString, SearchChar, -1, 1)  'textual comparison starting at the end.

'InstrRev counts from the end of the string so we have to switch that around for Right()
MyPos = Len(SearchString)-MyPos

Resultstr = Right(SearchString,MyPos)

'For testing only
'MsgBox"Resultstr has:"&Resultstr&Vbcrlf&"SearchString has:"&SearchString&" ", 0, "test"

'Write value to windows installer property.
Session.Property("MYNAMEIS") = Resultstr

The name of the property that is set at the end is: MYNAMEIS
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Should look like this:

You might want to get you hands on a VBS editor. You can get one that is fully functional
(with debugger) for up to 25 lines here http://www.adersoft.com/  You can also use an
outdated version of the VBS editor in the download section which doesn't have a debugger
but has no nags.

From Installation means you have to tell it where the file is for it to compile and it
knows that this file is not to be left on the target machine after it is done with it.

From Destination means that the file should already exist on on the target machine. The
file must exist on the machine used to compile the MSI.

From Installed files means that the file is part of the package(ie shows up in Installation
Expert) and will be left on the target machine after it is done with it.

Parsing with WiseScript
(With help from Wise KB Article #1956)
For an example, let's try to extract the name of MSI file from the OriginalDatabase property. The
OriginalDatabase property give us the name of the MSI file but it includes the full path, we want
to parse for the MSI file name only.

-Go to the MSI Script view:
-Select the Execute Immediate page
-Place it after the CostFinalize action (This is usually safe since most properties are now defined)
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-In the left column select Call WiseScript from Installation  
-Custom Action Name: MrParseIT (This is just a cutesy label, it's whatever you want.)
-For the WiseScript EXE file: MrParseIT (Again, whatever you want, I'm just consistent..)
-Click the Options button and select Create New WiseScript

-A Save As window appears. Browse to where you want your WiseScript to be save and
click the Save button. I would suggest the same directory as where your WSI is located. That way
all the files needed to build the package stays together.

-WiseScript Editor (or WiseScript Express) opens
-Paste in this WiseScript:

item: Remark
  Text=Read from windows installer property.
end
item: Custom Script Item
  Filename=Get Windows Installer Property.wse
  Variable Name1=_PROPERTYNAME_
  Variable Value1=OriginalDatabase
  Variable Name2=_PROP_VAR_
  Variable Value2=SearchString
  Variable Name3=HELPFILE
  Variable Value3=\\parisdmres02\WPSDIR$\HELP\WiseScriptEditor.chm
end
item: Remark
  Text= Search for "\".
end
item: Set Variable
  Variable=SEARCHCHAR
  Value=\
end
item: Remark
end
item: Remark
  Text=edit SearchString
end
item: Parse String
  Source=%SearchString%
  Pattern=%SEARCHCHAR%
  Variable1=JUNK
  Variable2=RESULTSTR
  Flags=00000100
end
item: Remark
end
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item: Remark
  Text=For testing only
end
remarked item: Display Message
  Title=test
  Text=Resultstr has: %Resultstr%
  Text=SearchString has: %SearchString%
end
item: Remark
end
item: Remark
  Text=Write value to windows installer property.
end
item: Custom Script Item
  Filename=Set Windows Installer Property.wse
  Variable Name1=_PROPERTYNAME_
  Variable Value1=MYNAMEIS
  Variable Name2=HELPFILE
  Variable Value2=\\parisdmres02\WPSDIR$\HELP\WiseScriptEditor.chm
  Variable Name3=_PROPERTYVAL_
  Variable Value3=Resultstr
end

Yea, it's gobbledygook alright. 
But if you paste in onto the WiseScript Editor it looks like this (Trust me!):

-Click Compile and exit out of WiseScript Editor.
-This will bring you back to your package and you'll have something like this:
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-Click Ok
-Click Compile to compile your MSI that will now contain the WiseScript.

Trivia Info: Did you know that MS' SMS installer is in fact an old version of WiseScript
Editor? You can in fact import an SMS installer file into WiseScript Editor. (not the otherway
around though)
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How to launch an EXE from an MSI

How to launch IE6 install from an MSI
It is possible to create an MSI file to initiate the install of IE6. The file to launch the IE6 install is
ie6setup.exe.  You could use the same idea to launch EXEs. (Taken from Wise newsgroups)

Solution #1
You need to get the MSI wrapper from MS directly.
http://support.microsoft.com/default.aspx?scid=kb%3ben-us%3b810011
Joseph White, MCSA
ONE's Technologies
jwhiteATNOSPAMonestech.com

Solution #2
You could use a MSI wrapper script, which could start the installation of IE.
One can be found at www.installsite.org under Windows Installer -> Tools and
Tips. It is called "MSI Wrapper to Deploy Internet Explorer with GPO" written
by Vincent van Egmond.
I have tried it a few times myself and it seems to work.
Please note that this is NOT in compliance with Microsoft or any well-known
practises to package and deploy IE via MSI. Your approach (using IE Admin kit),
creating an installation point of IE, is the way to go.
Michael Buchardt

Launch setup.exe from an MSI
Sometimes you need to keep the installation logic inside the setup.exe intact or you need to
automate the installation of a driver. You can do this with an MSI by using a custom action inside
a virtually empty MSI package. Microsoft Knowledge Base Article – 260301 covers this for
installing SP1 for Windows 2000 via GPOs. When deploying software using GPOs it is best to use
MSI Packages as much as possible.
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How to package a driver installation
Method 1: (Good luck!)
MS is working on this in MSI 3.0 and you can see this at:
http://msdn.microsoft.com/library/default.asp?url=/library/en-us/install/hh/install/install-
over_6fvr.asp

I read some of it and to use it you need to have signed drivers (.CAT files). They do explain how
to sign the files but for me it should be a hell-of-alot easier to do. Hence, be warned that this is still
in beta. MSI as it stands today does not handle drivers.

Method 2: (Tried and trued)
You can still do it if you have access to INF files for the drivers. 
(Taken from Wise newsgroups)
From: <John_McFadyen_370091>
Subject: Re: AutoInstallation of drivers
Date: April 20, 2004 6:31 PM
INF Files can be used to install and remove applications, general files, etc.
To script an INF file to install or remove, you call the RunDLL32 application
from a script using the following syntax:

Windows 9x
Installation: 
rundll.exe setupx.dll,InstallHinfSection DefaultInstall 132 %1
Where %1 is the path and file name of the INF file to install
Uninstall:
RunDll setupx.dll,InstallHinfSection DefaultUninstall 4 %1
Where %1 is the path and file name of the INF file to uninstall

Windows NT/2000/XP
Installation: 
rundll32.exe setupapi,InstallHinfSection DefaultInstall 132 %1
Where %1 is the path and file name of the INF file to install
Uninstall:
rundll32.exe setupapi,InstallHinfSection DefaultUninstall 132 %1
Where %1 is the path and file name of the INF file to uninstall
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Merging the contents of a MST file into an MSI file
This is to make the MSI absorb the changes from the MST permanently.
(Taken from Wise newsgroups)
From: "Edward Tippelt"
Subject: Re: Embedding an MST file into an MSI file...
Date: Thursday, September 05, 2002 3:06 PM
Load ORCA, which comes with the Windows Installer SDK.
File/Open the MSI.
Load the MST from Transform/Apply Transform.
Then File/Save Transformed As....
EdT

(Taken from Wise newsgroups)
From: <Glenn_Ashby_133318>
Subject: Re: Embedding an MST file into an MSI file...
Date: Tuesday, September 17, 2002 6:00 AM
The Windows XP Resource Kit contains a file called MSITRAN.EXE which allows you
to combine your Transform into your MSI and leaves you with ONE MSI file to run
with your transform applied to it. 

Lookup MSITRAN.EXE in the SDK (click ) on how to do this.

How to delay a Custom Action in MSI script
There is no built-in command to do a delay in MSI script in WPS 4.0 and below. Obtain a program
called Scriptnap.exe from the Internet. It was designed for this exact purpose.
-Copy this file to the C:\Program Files\Wise Package Studio\Windows Installer
Editor\Resources folder
-Go to the MSI Script view:
-Select the Execute Deferred page
-Place it after the InstallFiles action (or wherever you need the delay)
-In the left column select Execute Program From Installation 

-Custom Action Name: Delay 
-Executable file: <browse to Scriptnap.exe>
-Click Ok

-Save the WSI
-In the Installation Expert view while in your WSI:
-Go to Product Definition section select Resources 
-Click add
-Name: CallScriptnap
-Filename: [WisePath]\Resources\Scriptnap.exe 
-Click Ok
-Check the refresh box for the CallScriptnap resource
-Save the WSI

NOTE: WPS 4.5 & up have a new MSI Script command called Pause that does this for you.

How to use an EXE inside MSI Script without installing it on the PC
See “How to delay a Custom Action in MSI script” and replace Scriptnap.exe with your EXE.
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Launching batch files
You can make create a custom action that launches the batch file.
If you want the full details go to the Wise Support section and search for Article #468

The IF statement in MSI script

How to do a conditional delete using a DOS command
Unlike most programming languages, the IF statement in MSI script is broken down in 2 parts. 
In the System Search it does all the tests but does not act on them, it just stores the results inside a
Property that you specify. It is preferred to use all UPPERCASE for the name of the property since
that will make it a Public property and guarantee that you can see it everywhere. 
In the MSI Script view is where you have your traditional IF statement. There you just refer to the
value of the Property that was set and act accordingly.
The catch with using DOS command in MSI Scripts is that it checks the ERRORLEVEL.
Therefore if the DOS command fails, MSI will deem that the entire package failed and rollback.
To prevent this, use the property tab and change Synchronous to Synchronous, Ignore Exit code,
in the custom action that launches the DOS command. In this example we want to delete the
C:\OldStuff folder before install our application. To do this we are looking for a file named
unsetup.exe inside a folder called C:\OldStuff\SETUP. If we find it, we want to remove the entire
C:\OldStuff folder, subfolders and their contents. If it doesn't find it we want it to just install
normally.

This is an over-elaborate example since it would be much simpler to use a Conditional feature to
delete the folder instead of a batch file. But I had this in my notes and it does show an idea.

Example to conditionally delete C:\OldStuff
While in the Windows Installer Editor 
In the Installation Expert view:
In Target System section select System Search 
-Click Add
-Select File or Directory
-Property: OLDSTUFFEXIST
-Operation: Search for file: return full file name
-Search Directory: C:\OldStuff\SETUP
-File name: UNSETUP.EXE
-Click OK 
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Go to the MSI Script view:
-Select the Execute Deferred page (At the bottom)
-Just before the CreateFolders action add the following:
-Remark: Check for and remove C:\OldStuff
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-If statement: OLDSTUFFEXIST   and click Ok
-Execute Program from Path:

-Custom Action Name: RipOutOldStuff 
-Property: %COMSPEC
-Exe and Command line: /c rmdir /s /q C:\OldStuff

-Click on Properties tab
-For Processing, change Synchronous to Synchronous, Ignore exit code 

Page numbers



-Click Ok

-Pause installation:
-Seconds to pause:  2

-End statement:
The result will look like this:

Note: This is an over-elaborate example since it would be much simpler to use a Conditional
Feature to delete the folder instead of a batch file. But I had this in my notes and it does show an
idea.

Files are placed on hard drive/partition with most space
It seems that windows NT/2000 installs software on the hard drive with most space available.  To
prevent this create a new property in the property table called ROOTDRIVE and make the value
"C:\" (Without the quotes of course)
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New users don't get their profile fixed-up

Only the user that installed the application works

What is ActiveSetup?
Sometimes an application will not work for users other that the user that installed it. If the package
is a true MSI, normally new users will trigger self-healing to complete the installation if it's
needed. This precess updates the user's hive and/or profile. But sometimes this process doesn't
work. 

Try to use the /FU switch as the new user:
MSIEXEC /FU {Product_ID_of_your_package}

If MSI launches and the application does function there after then we have to automate the fix.
Since we now know we can rely on MSI alone we must use something else: ActiveSetup.
ActiveSetup is an older idea from MS to handle configuring applications for multiple users on the
same machine. Ed Tippelt does have a great explanation on how to use it at: 
http://www.etlengineering.com/installer/activesetup.txt

If not, then you have a poorly crafted MSI that will work only for the user that installed it.
Sometime setting the ALLUSERS Property to 1 can help. If you created it from scratch, do what
follows into the MSI. If didn't create the MSI and still want support from the developer, create a
transform (MST) and do what follows in it.
-Check that user's profile for changes and add them in.
-Check that user's hive for changes and add them in.

 Yes, this is inherently a hit or miss attempt to fix things. If you are the developer or don't mind
having no support, you do have an additional method at your disposal: re-package using
SetupCapture.
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How to prevent /stop MSI from rebooting
Create a Property called REBOOT and give it this value: ReallySuppress
More info here: http://www.appdeploy.com/tips/detail.asp?id=27

Beware of spaces before and after in Properties. They count as characters!
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How to make an MSI unattended by default
By default, when you double-click on an MSI file it prompts you to click Next until you finish
installing the application. You can run the MSI unattended from the command line using the /QN
switch but that requires typing. What if you need/want to be able to double-click on the MSI file
and have it run the MSI unattended? Here's how:
-Go to the Setup Editor view:
-Click the Dialogs tab and un-select the following:

-Install Dialogs -> Welcome Dialog Wizard
-Install Dialogs  ->  Exit Dialog
-Maintenance Dialogs  -> Exit Dialog
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Trap: Properties set at the command line are lost at uninstall
One of my colleagues set some property at the command line to dynamically create a directory at
install time. The package would install fine but at removal time, the package could not remember
what the property was set at at install time and the uninstall would fail.
Solution: The package was redone to set the property dynamically via an internal VBS script.
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FAQs
Substitution
To substitute the value of a property in a text box or in a Custom Action or a dialog box use square
brackets:    [ALLUSERS]

To substitute the value of an environment variable in a text box or in a Custom Action use square
brackets with a % sign before the name of the environment variable:    [%USERNAME]
NOTE: You do not use [] in the tables. Just type in the Property name directly.

Gotcha: You cannot set a property based of the value of another property. This is necessary
to prevent creating circular references in the Property table (aka which gets its value first). Instead,
you can set one property based on another by using a Custom Action Type 51.

Order of Precedence for Properties
(Note: The following was taken from the MSI SDK, click .)
The installer sets properties using the following order of precedence. A property value in this list
can override a value that comes after it and be overridden by a value coming before it in the list. 

1. Properties specified by the operating environment. 
2. Public properties set on the command line. 
3. Public properties listed by the AdminProperties property set during an administrative

installation. 
4. Public or private properties set during the application of a transform. 
5. Public or private property that set by authoring the Property table of the .MSI file.

+ - or * characters in the registry value of an .MSI file
From: "Edward Tippelt" <santaATnospam.pobox.com> (WPS newsgroups)
From the SDK Help file, searching under "Registry table":

+  The key is to be created, if absent, when the component is installed.

-   The key is to be deleted, if present, with all of its values and subkeys, when the component is
uninstalled.

*   The key is to be created, if absent, when the component is installed.
Additionally, the key is to be deleted, if present, with all of its values and subkeys, when the
component is uninstalled.
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Quirks with INI files
(Taken from Wise newsgroups)
INI files and SetupCapture Andre Lefebvre alefebvrATNOSPAMzdnetmail.com

I'm working on repackaging an application containing many INI files.  Those INI files may contain
comment lines (;) and also variables with no value.  Here is a sample of what an INI file can look
like:    [Section]

; this is only a comment
Var1=Something
Var2=
Var3=

The empty variables are really important for the application to work.  My problem is that
SetupCapture removes all comments and empty values at compilation.  

Is there any way I can tell SetupCapture to treat INI files the same way as any other TXT file?  I
only want INI files to be copied as is to the target computer, without any modification.

Answer:
When I have the same problems I usually skip WPS’s way to create the INI files and add them as a
file instead. And during installation the INI file is treated like any other file and just placed where
you want it.

I think if you use
var2=""
That will get around one of your problems.

Gotcha: When you Capture a setup that contains INI files, Wise Package Studio (and most other
capturing packages) take the INI files apart line by line. This process will LEAVE OUT anything
that is not needed in the INI file. This includes comments, incomplete lines and non-standard
lines. Some applications add tonnes of comments inside their INI files to explain how to configure
them. And some rare applications will have a bastard way of using the INI extension for files that
are in fact not INI files at all! For these applications, you must remove the INI files from within the
INI files section in WPS and add them back in as regular files.

The Clean PC image needs to be rejoined all the time!
Change the DisablePasswordChange registry key to 1 to avoid the Ghost image going out of date
in 7 days when the workstation account password changes on the server.

[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\Netlogon\Parameters]
"DisablePasswordChange"=dword:00000001

Note: this will work only if your network does not try to change this setting via GPO!!
otherwise you'll have to rebuild a new image OR manually un-join (ie join a workgroup) and rejoin
the domain.
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WPS: How to DL additional Merge Modules
If you have already extracted the Merge Modules from your installation CD (See building your
"Rig") and you suspect Wise might have more up-to-date modules then this is the way to check
and download in one shot.
-On the “Packaging server”, launch WPS
-Open Windows Installer Editor 
-Open a blank WSI
-In Feature Details section select Merge Modules
-Click Add
-Click Ok
-Select any modules, click Download
-Download redistributables; click Next
-It retrieves the list from Wise and compares it to the Merge Modules already installed on the
“packaging server”
-Check the required modules on the Available modules column
-Click Next

You can also get more of them at http://  www.installsite.org  /   under Merge Modules. Some of them
are user-created.

Applying multiple Transforms to one MSI 
(Taken from the MSI SDK under TRANSFORMS property)
“For example, to apply three transforms to a package, set the TRANSFORMS [property] to a list
of file names or to a list of full paths.” ie:
TRANSFORMS=transform1.mst;transform2.mst;transform3.mst

MSIEXEC /i MyApp.MSI TRANSFORMS=transform1.mst;transform2.mst;transform3.mst

 Caveat: This will work in a batch or CMD file but does NOT work in a shortcut.  If
you try you will get this:

       

Using ORCA to edit MST files
(Taken from Wise newsgroups)
In order to edit the MST with ORCA, you need to load the MSI first, then the
MST. The ORCA display then shows the effect of the MST on the MSI. In this
scenario, the MSI is not changed. Any changes you make are only to the MST,
which you can save when you have finished.

EdT
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How to Enable Windows Installer Logging
(From Microsoft Knowledge Base Article – 223300)
Windows Installer can use logging to help assist in troubleshooting issues with installing software
packages. This logging is enabled by adding keys and values to the registry. After the entries have
been added and enabled, you can retry the problem installation and Windows Installer will track
the progress and post it to the Temp folder. The new log's file name is random, but begins with
the letters "MSI" and end with a .log extension. 

To locate the Temp folder location:
type the following in the address field of Windows Explorer: %temp% 
or
type the following at a command prompt: cd %temp% 

Open the registry with Regedt32.exe and create the following path and keys: 
HKEY_LOCAL_MACHINE\Software\Policies\Microsoft\Windows\Installer
Reg_SZ: Logging
Value: voicewarmup 

The letters in the value field can be in any order. Each letter turns on a different logging mode.
Each letter's actual function is as follows for MSI version 1.1: 

v - Verbose output
o - Out-of-disk-space messages
i - Status messages
c - Initial UI parameters
e - All error messages
w - Non-fatal warnings
a - Start up of actions
r - Action-specific records
m - Out-of-memory or fatal exit information
u - User requests
p - Terminal properties
+ - Append to existing file
! - Flush each line to the log

"*" - Wildcard, log all information except for the v option. To include the v option, specify "/l*v". 

NOTE: This should be used only for troubleshooting purposes and should not be left on because it
will have adverse effects on system performance and disk space. Each time you use the
Add/Remove Programs tool in Control Panel, a new MSI*.log file is created.
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How to Enable Logging for GPO Application installation
(From Microsoft Knowledge Base Article – 246509)
When a program that is deployed through Group Policy is not installed correctly on a client
computer, a log file can be generated that records the steps of the Group Policy Application
Deployment component leading up to the unsuccessful installation. This information, in
conjunction with logging from the Windows Installer service, can be very helpful in determining
the cause of the problem.

To enable verbose logging of Application Deployment operations, add the following registry value
on the client computer. Delete this value after troubleshooting to avoid performance degradation: 
Key: HKEY_LOCAL_MACHINE\Software\Microsoft\Windows NT\CurrentVersion\Diagnostics

Note that you may need to create the Diagnostics key. 

Value: AppMgmtDebugLevel
Type: REG_DWORD
Data: 4b 

The logging file is named Appmgmt.log and is located in the %SystemRoot%\Debug\Usermode
folder on the client computer.

When to use the MSI Cleanup Utility
Available at  http://support.microsoft.com/default.aspx?scid=kb;en-us;290301
is a last-hope type of utility to fix a very specific type of problem that may happen through over-
tweaking or corruption. MSI keep track of what packages it has installed and this utility makes it
selectively forget one or more of these packages.

You may end up in this weird situation where you can't install an MSI package because of a entry
in the MSI tracking database says that the package is already installed and won't let you re-install
without a removal. A removal attempt, however, is not permitted or not possible due to corruption
or interaction with other software. This utility breaks the stalemate by helping you make the MSI
tracking database forget it installed the package in the first place. The catch is that YOU must
choose which package entry to blank out. As the MS link above mentions, this utility does not
uninstall the package, delete files or registry entries. You are responsible for that cleanup.

How to extract the files inside an MSI file

MSIEXEC /a MyPackage.MSI /c

A window will pop up and ask you where to put them. This will also place the files in sub-
directories if that’s how they are inside the MSI.
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Troubleshooting
Troubleshooting Unwanted Repairs with Event Viewer

1. Install as an admin, check application event log for MSI installer errors
2. Test as an admin, check application event log for MSI installer errors
3. Test as Limited user, check application event log for MSI installer errors
4. Test as a second user, a limited user, check application event log for MSI installer errors

Note:If your package includes changes to the User hive, then MSI will trigger to install those
changes the 1st time a user launches that application. (This is normal) 

If MSI triggers over and over again for the same user then your “KeyPath” is probably a moving
target for that component. See “Troubleshooting Unwanted Repairs with Event Viewer” Wise
Article #: 1531.

WPS: Can I still compile MSIs if I loose my database(s)
As long as you have the WSI and the source files (loose files or inside the MSI) you can. If you
have files that were located in the file conflict repository then that may cause some problems
depending on the situation.

WPS: Re-Installing WPS Pro on the “Packaging server”

WPS: Moving the Sharepoint to a new location
If for one reason or another you must re-install Wise Package Studio Pro on the “Packaging
server”, the biggest concern is what happens to the contents of the Wise SharePoint . An initial test
showed that very little is touched. The conflict database seems to not be touched but it wasn’t
being used prior to the test. The projects folder, the most important folder, was not touched at all.
The safest thing to do is to backup the entire Wise SharePoint  and try it.

Update: I talked to Wise tech support. He said that you move the SharePoint  physically and then
you rebuild the index file in Software Manager. (Setup menu -> Network Index Properties,
“Rebuild using file/directory Structure”)
This will rebuild the wamdb.idx file in the SharePoint . That’s it!

Note: This scenario was with Wise Package Studio v4.01. It may or may not apply with more
current versions of WPS. Backup your SharePoint  before such thing. In Wise Package Studio
version 5 and up, you might need to run DBSetup.exe after moving.  
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WPS: Infamous bugs and their workarounds
These bug are infamous because they stay around from one version to the next.

The Path in the registry encoding bug ([! vs. [# )
In the registry, if a file path is specified (i.e. C:\Program Files\My App\My Program.exe) it is
encoded as [!MyProgram.exe] which specifies to use the "Full short path of the file" (aka [! = 8.3
file path). When you install the MSI, the path is then restored to the registry as
C:\Progra~1\MyApp~1\MyProgr~1.exe and will make some applications fail. The proper encoding
should have been [#MyProgram.exe] which would give the long path name. This bug occurs in
most packages since at least WPS 3.2. UPDATE: I now suspect that this bug is caused by using
SmartMonitor in conjunction with Snapshot when performing a SetupCapture.

How to do a search in the tables for [!
-In Setup Editor view, Tables tab, press Ctrl-F and enter [!
-When one is found, check to see if that value in the registry of the Snapshot PC has the Long path
or the Short path. If its long file path change the “[!” to “[#”. Otherwise leave it as “[!”. Don't just
change it for the hell.

For more info on this, lookup the SDK for the section called Formatted
BTW: You cannot perform searches in Installation Expert view in the Registry node.

The extra \ at the end of a registry path encoding bug
This is caused by WPS encoding a registry path like this:

[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Direct3D\]
The extra back slash at the end will cause the following ICE error: 

ICE03 ERROR Invalid registry path; Table: Registry, Column: Key, Key(s):
registry682

If you look up the path in the Installation Expert it will look fine. If you look this up in the
“Registry” table, however, the path has additional “\” at the end. This is one of the “Infamous Wise
Encoding Bugs”. 
In WSP 4.51, Wise has noticed the problem and attempted to fix it. But instead the fix is to create
duplicate entries without the extra back slash.  The bad entries cause ICE errors. To fix this YOU
must delete the bad entries from the “Registry” table. UPDATE: I now suspect that this bug is
caused by using SmartMonitor in conjunction with Snapshot when performing a
SetupCapture.

Deleted files don’t always get deleted
Windows Installer Editor - Installation expert
In some packages, when you delete a file, the file disappears from Installation Expert but still
shows up in the tables (Files, Components, etc). You do other things and come back to Installation
Expert and find the deleted file back from the dead. To fix this you must delete them from the
tables. Check the RemoveFile table too! 

Temp files are not ignored
SetupCapture picks up files in the current user's Local File\Temp even though that folder is in the
exclusion file! You have to go back and make sure that it is deleted. Sub-directories in
Winnt\TEMP are also included for no reason. You must delete them from the tables. Check the
RemoveFile table too!
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The “Change all paths to relative” button doesn't work
In Windows Installer Editor, Tools menu, Change Source Paths

This is a bug with all paths that start with [path variable]. Use of path variables is the default
setting in WPS. For a workaround see Procedures. The functionality behind the Change all paths
to relative button cannot handle “Wise Path Variable” in the source Paths. This is a big deal since
Wise Package Studio v3.x to 5.1 to use “Wise Path Variable” by default! 
(Please ask Wise to fix this since my bug report was ignored.)

BTW: Even if you change the “Path Type” thing at the bottom to Relative Paths, WPS still plugs
the “Wise Path Variable”! Files are always added with an Absolute Source Path.
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